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PART 1: ON1 RESIZE 2018 OVERVIEW

ON1 Resize 2018 is a professional-quality resizing tool that also incorporates a complete photo organizer. 
Resize 2018’s features also include:

• ON1 Resize: Resize gives you the highest quality photo enlargements of any resizing tool on 
the market. Using the patented, industry-standard Genuine Fractals algorithms, you can 
enlarge photos without the loss of sharpness or detail.  

• Browse: Resize 2018 includes the core Browse module from ON1 Photo RAW 2018, giving 
you a lightning-fast browser and organizer. Simply point it to any folder of photos to preview, 
sort, tag and change metadata instantly.

• Batch Processing: The Export feature in Resize 2018 makes it easy to process a single photo or 
hundreds of them. Not only can you control the size, but the file type, naming, location, and 
so on. You can even apply gallery wrap or watermarks on the fly. 

• New RAW Engine: Resize 2018 features the RAW processing engine from ON1 Photo RAW. 
When you browse, preview and resize RAW photos, this powerful engine gives you fast, true-
to-life color and detail.

• Printing: You can print from right inside of Resize 2018. Control the paper size, margins and 
printer profiles for the ultimate print.

Flexible Workflow
ON1 Resize 2018 incorporates a state-of-the-art Raw processor, which lets you quickly sort, categorize and 
view Raw photos in Browse, and then create the highest quality photo enlargements—using the patented 
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Genuine Fractals algorithms—to enlarge photos without the loss of sharpness or detail.

If you have an existing image editing and workflow app such as Adobe’s Photoshop, Lightroom or 
Photoshop Elements, ON1 Resize 2018 can also work as a plug-in to these apps, giving you direct access to 
all of Resize’s image scaling options.

Using the Help System
Find and watch free video tutorials at the ON1 Resize 2018 Product Training site, available at ON1.com. 
This is the best and quickest way to dig into the ON1 workflow and discover new techniques that will help 
you with your photo editing and organizing. There, you can search our Knowledge Base for frequently 
asked questions, common issues and more.

System Requirements

MINIMUM RECOMMENDED
OPERATING SYSTEM Mac OS 10.9 through 10.13

Windows 7, Windows 8 or 
Windows 10 current releases, 
64-bit only

Mac OS 10.12, 10.13

Windows 10 current releases, 
64-bit only

PROCESSOR Intel Core 2 Duo, Xeon or 
better processor

Intel Core i5, Xeon or better 
processor

RAM 4 GB (8 GB when used as a 
Photoshop plug-in)

16 GB RAM

HARD DRIVE 1.5 GB for installation 1.5 GB for installation

Fast (7200 RPM) or SSD drives 
for optimal performance

DISPLAY OpenGL 3.3 compatible video 
card with 512 MB video 
RAM,1280x720 resolution

OpenGL 4.2 compatible video 
card with 1 GB dedicated video 
RAM, 1920x1080 resolution

THIRD-PARTY APPS 

SUPPORTED (PLUG-IN)

Photoshop CS6, CC (all versions) 
Photoshop Elements 13, 14, 15, 2018 
Photoshop Lightroom 5 and 6, Lightroom Classic CC (all versions)

OTHER Internet connection for 
activation, auto update 
checking, content downloads 
and tutorials.

Internet connection for 
activation, auto update checking, 
content downloads and tutorials.

Wacom tablet for pressure-
sensitive input

Hardware display calibration tool

https://www.on1.com/blog/category/product-training/
https://on1help.zendesk.com/hc/en-us
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Installation
To install ON1 Resize 2018, double-click the installer icon and allow the installer to guide you.

Be sure to close any supported host applications—such as Adobe Photoshop, Elements or Lightroom—as 
well as any previous versions of ON1 products before installing or updating.

MAC OS

The application is installed in the ON1 Resize 2018 folder in the Applications folder.

All plug-in files for supported host applications (such as Adobe Photoshop, Lightroom, or Photoshop 
Elements) found during the installation process will be installed automatically. You will see a summary of 
installed plug-ins at the end of installation.

If a previous version of ON1 Resize, Perfect Photo 10 or Perfect Photo Suite is found, it will be maintained 
or replaced based on your preference during installation.

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.

WINDOWS

The application is installed in the ON1 Resize 2018 directory in the ON1 directory in the Program Files 
directory.

All plug-in files for supported host applications (such as Adobe Photoshop, Lightroom, Photoshop Elements) 
found during the installation process will be installed automatically. You will see a summary of installed 
plug-ins at the end of installation.

If a previous version of ON1 Resize, Perfect Photo 10 or Perfect Photo Suite is found, it will be maintained 
or replaced based on your preference during installation.

Support files are installed into \ProgramData\ON1\ on Windows.

Launching ON1 Resize 2018
To launch Resize 2018 as a standalone app, with access to all modules, follow these steps:

MAC OS

1.	 Open your Finder.

2.	 Navigate to the Applications folder.

3.	 Navigate to the ON1 Resize 2018 folder.

4.	 Double-click on the ON1 Resize 2018 application icon.
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You can add ON1 Resize 2018 to your dock for easy access by clicking and holding the icon in the dock and 
selecting the Keep In Dock option. If you use Launchpad it can be found there as well.

WINDOWS 7

1.	 Go to your Start Menu.

2.	 Select the ON1 group.

3.	 Select ON1 Resize 2018.

4.	 If you selected the “Add Icon to Desktop” option during installation, you can also access 
ON1 Resize 2018 from there.

WINDOWS 8.1 AND WINDOWS 10

1.	 Open the Start screen by pressing the Window key.

2.	 Select ON1 Resize 2018.

3.	 If you selected the “Add Icon to Desktop” option during installation, you can also access 
ON1 Resize 2018 from there.

To launch ON1 Resize 2018 from an external application, such as Adobe Photoshop or Lightroom, see the 
sections below for complete instructions.

Licensing and Registration
When you first launch ON1 Resize 2018, you will be presented with a window asking you to activate your 
software. In this window, you can either enter your ON1 account information (if you have purchased the 
app) or can start a free trial of the app.

IF YOU HAVE PURCHASED ON1 RESIZE 2018:

Click on the “ON1 Resize 2018 Owners Sign-in” button and fill in 
your ON1 account information (email and password) to register 
the app with us. (You should have set up an account when you 
purchased the software.) If the computer you are signing in with 
does not have access to the internet, you can manually register 
your software by clicking on the “No Internet connection” link in 
the license dialog.

Your license lets you install ON1 Resize 2018 on five computers. 
When you enter your ON1 account info, Resize 2018 
communicates with the ON1 activation server and registers your 
software for that computer.

If you wish to move your copy of ON1 Resize 2018 from one 
registered computer to a new one, and you are not going to be 

When you first launch ON1 Resize 2018, you can sign in 
with your ON1 User ID (which you set up at purchase), or 
you can click the orange button to start a free trial.
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using the older machine, it is best to sign out of the old computer first. Open Resize 2018 and select Sign 
Out from the Help menu. This will turn off Resize 2018 on the current machine, and you can install and sign 
in on another machine.

You can log into your ON1 user account area (https://www.on1.com/login/) at any time to download the 
software, see the number of computers you have registered, and make basic changes to your account 
information, including updating your email address, changing your password, and turning notifications on or 
off.

If you have issues related to installing or activating Resize 2018, please contact ON1’s customer support, 
which can be reached by clicking on the Support tab (https://on1help.zendesk.com/hc/en-us) on the main 
ON1 website.

TRIAL VERSION

ON1 Resize 2018 can also operate as a fully featured trial version for 30 days from when you first launch 
it. This gives you time to evaluate the product and see if it fits your needs. If you have downloaded Resize 
2018 to try it out, simply click on the Trial button in the Activation window. Each time you launch ON1 
Resize 2018 during the trial period, you will see the window, which will tell you how many days remain in 
the trial.

You can purchase ON1 Resize 2018 at any time from this window by clicking on the Purchase button. If you 
do that, just enter your ON1 account information the next time you launch the product and the activation 
window will no longer appear.

PRODUCT IMPROVEMENT PROGRAM

We believe that the best products are made by listening to our customers. We use many methods to 
gather your ideas and feedback including: emails, surveys, direct conversations, market analysis and the 
Product Improvement Program. The Product Improvement Program is built into our software and gathers 
information about how our software is used. It is the most accurate way for us learn what features are 
important to you and how our products fit into your workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you 
use our programs and basic information about your computer. This information helps us learn what features 
are important to you and how we can make our software easier to use. No personal information is collected 
and you will not be contacted.

You can choose to participate in the Product Improvement Program the first time you launch ON1 Resize 
2018. You can change your participation later, just click the Help menu, then Help Improve ON1, Inc. 
Products.

To learn more about the Product Improvement Program, go to the Support area of the ON1.com website.

https://www.on1.com/login/
https://on1help.zendesk.com/hc/en-us
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Uninstalling ON1 Resize 2018
To uninstall ON1 Resize 2018, first deactivate your product: open ON1 Resize 2018 and select Sign Out… 
from the Help menu. (This will allow you to transfer your license to another computer.) 

MAC OS

1.	 Go to the Applications/ON1 Resize 2018/Documentation folder.

2.	 Double-click on the Remove ON1 Resize 2018 application.

WINDOWS

1.	 Go to Control Panels.

2.	 Under Programs select ‘Uninstall a program.’

3.	 In the list that comes up select ON1 Resize 2018 and then click on the Uninstall button.

Working with Files
ON1 Resize 2018 supports the following file types, in RGB color mode, either 8 or 16 bits per pixel.

• Raw files from most major camera manufacturers (file extension varies by manufacturer)

• Digital Negative (DNG)

• Photoshop (PSD)

• Photoshop Large Document (PSB)

• Tagged Image File Format (TIFF)

• Joint Photographic Experts Group (JPEG)

• Portable Network Graphic (PNG)

NOTE: ON1 Resize 2018 can also view most standard video formats inside 
the Browse module. While you cannot play video, you can perform file 
management tasks and edit metadata. (Double-clicking on a video file in Resize 
will launch the default video player for your computer.)

ON1 Resize 2018 Modules
ON1 Resize 2018 has two modules: Browse and Resize. Each module focuses on one task, giving you access 
to just what you need to get that task done. Browse handles all file-management and image browsing 
operations, and Resize is used to enlarge images, largely for printing to large-format printers.
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When used as a standalone application, Browse is the default module at first launch, and it is used to 
navigate your drives and cloud services to find images to begin working with. You can switch between the 
Browse and Resize modules by clicking on the appropriate icon in the module selector on the right side of 
the screen. 

When you use ON1 Resize 2018 as a plug-in for other apps, Browse is not accessible.

Using Resize 2018 with Adobe® Photoshop®
ON1 Resize 2018 is accessible from within Photoshop via the File > Automate menu. Selecting that item 
will open the image in Resize. When you are finished resizing your image, clicking the Done button inside 
Resize will apply the transformation and save it back to Photoshop at the new dimensions. (Clicking Cancel 
inside Resize will close the file without making changes.)

Using Resize with Adobe® Lightroom® Classic CC
ON1 Resize 2018 can be accessed from within Lightroom Classic CC, providing an integrated, round-trip 
workflow of your images. 

There are two primary ways to use ON1 Resize 2018 with Lightroom, via the Plug-In Extras command in 
the File menu and the Edit In command in the Photo menu. 

USING ‘PLUG-IN EXTRAS’

Accessing ON1 Resize 2018 from the File > Plug-in 
Extras menu is the preferred way to access the app. 
It gives you the most flexibility in how the files are 
handled, and also provides a bit better experience 
should you decide to cancel your session in Resize 
without saving changes. To edit an image in ON1 Resize 
2018, select the image in Lightroom, go the File menu 
and select the Plug-In Extras submenu, and choose the 
module you would like to use.

File Creation Characteristics When Using Plug-In Extras

When you use ON1 Resize 2018 through the Plug-In Extras menu, there 
are important file-handling options that are controlled in the ON1 Resize 
2018 Preferences dialog. These need to be configured in advance based 
on your desired workflow. Once these are set, all images sent to Resize 
2018 via the Plug-In Extras submenu will use these characteristics:

• Save Photoshop Files As: Controls how Photoshop files opened 
from Lightroom are saved, as smart photos or regular PSDs.

• File Type: The file type drop-down menu determines what type 

When sending a file from Lightroom to Resize 
via Lightroom‘s Plug-In Extras menu, the 
edited file will be created according to your 
settings in the Files section of Resize’s 
Preferences window.

The Plug-In Extras submenu, is found in Lightroom’s File menu.
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of file will be created. The default is PSD, which maintains layers. You can also select JPG or 
TIFF, if you prefer those formats and are not concerned about maintaining layers.

• Color Space: The color space drop-down menu determines what RGB working color space is 
used; Adobe RGB 1998, sRGB or ProPhoto RGB.

• Bit Depth: The bit-depth drop-down menu determines the bit depth, either 8-bit or 16-bit per 
pixel.

• Resolution: The resolution drop-down menu determines the resolution of the file.

USING ‘EDIT IN’ FROM LIGHTROOM

For quick resizing of photos in Resize, select your image in 
Lightroom, go to the Photo menu, select the Edit In submenu 
and choose ON1 Resize 2018. 

When you use the Photo > Edit In submenu, Lightroom will 
ask you each time how you wish to edit the selected image. 
You have three editing options—Edit a Copy with Lightroom 
Adjustments, which makes a copy of the file that includes any 
edits you have made in the photo; Edit a Copy, which copies the original photo without any changes made 
in Lightroom; or Edit Original, which is not available if the photo being sent to ON1 Photo is a raw file.

You can also can set the type (TIFF, Photoshop or JPEG), the color space and bit depth for the resultant file. 

Printing
ON1 Resize 2018 has full printing capabilities built directly into the product, and you can print your photos 
from either Browse or Resize, using the Print command from the File menu.

To print an image, follow these steps:

1.	 Select Print from the File menu.

2.	 Select your printer from the Printer pop-up.
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3.	 Press the Print Setup button to adjust printer specific options such as paper size and type 
and printer specific color management options.

4.	 Adjust the number of copies, orientation and output resolution.

5.	 In the Print Area section set the area to fit, fill or actual size. The preview on the left shows 
the paper size and margins as well as the print area and how the image will fit or fill the print 
area. (When using Fill Entire Area, you can move the photo around the print area box.)

6.	 Select the output Printer Profile and Rendering Intent to properly adjust the photos colors 
to your printer and paper combination. You may also select the Printer Managed Color 
option to let your printer driver manage the color instead.

Preferences
ON1 Resize 2018 has a number of system-wide settings that you can set via the Preferences window. To 
access Preferences, either click on the gear icon at the lower left side of the screen, or choose Preferences 
from the ON1 Resize 2018 menu (Mac OS) or the Edit menu in Windows.

The Preferences window has six tabs: General, Files, Plug-Ins, System, Services, Photo Via. The settings in 
each tab are described below.

GENERAL SETTINGS

The General settings tab adjusts basic settings 
for the Resize workspace, including background 
color, scrolling controls and more.

Scrolling Controls

Lets you select how the mouse scroll wheel or 
scrolling gesture works. The options are:

• None: Default.

• Preview Zoom: Adjusts the zoom of the preview window. Scrolling up increases the zoom, 
scrolling down decreases the zoom.

• Preview Pan: Pans the image, like using the pan tool or navigator. It is important that the 
panning is comfortable, not too fast or slow or jerky.

• Brush Size: Adjusts the size of the current tool if relevant, such as a brush tool.

Preview Background Color

You may select the color of the background behind the preview image. The default color is black. There is 
options for black, white, light gray, dark gray and custom. The custom option has a color picker where you 
can select your own background color.
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Accent Color

Lets you choose the display color for highlighted items (folders, tabs, selections) in the Resize interface.

Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start ON1 
Photo; if an update is available it will prompt you to download or skip the update.

FILES

The Files tab is used to determine what file type 
ON1 Resize will create when opening a file as 
a plug-in from an external application, or when 
creating copies to send to an external photo 
editor from within Browse.

What to Edit

There are five options in this section:

1.	 File Format: Sets the file type you 
wish to create: PSD, TIFF, or JPEG.

2.	 Color Space: Sets the default color 
space when opening a copy of a file; 
the list includes Adobe RGB 1998, 
Apple RGB (Mac OS), sRGB, ProPhoto RGB, or ColorMatch RGB. (If you imported a profile 
for use in the General preferences, it will also be available here.)

3.	 Bit Depth: Sets the bit depth for the file when opening a copy of a file.

4.	 Resolution: Sets the resolution when opening a copy of a file.

5.	 Show these options every time: If you do not wish to use a predefined set of file characteristics 
for opening photos from Lightroom or Photoshop, click this box.

Sidecar Options

Click this box if you wish ON1 Resize 2018 to create ON1-specific ‘sidecar’ files when you are editing 
images in Browse. This is helpful if you are using the same image library with multiple computers (on an 
external hard drive, for example), and want your edits to be visible on each machine.

Apply Lens Correction Automatically

With this option on, ON1 Resize will use the lens correction automatically on any raw photo when you view 
it in Detail, Filmstrip or Compare modes.
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PLUG-INS

The Plug-Ins tab is specific to using Resize as a 
plug-in for Photoshop or Lightroom, and lets you 
set up conditions when opening files from these 
apps.

Photoshop

• Apply Results to: When editing in 
Photoshop you can choose to have 
your effect added to a copy of your 
current layer or to the current layer. 
(This option is not used by Resize, and 
can be ignored.)

Lightroom

This preference lets you choose the specific options for files opened via the Plug-In Extras menu in 
Lightroom:

• File Type: The file type drop-down menu determines what type of file will be created. The 
default is PSD, which maintains layers. You can also select JPG or TIFF if you prefer those 
formats and are not concerned about maintaining layers. The last option is same as source, 
which maintains the file type of the original file, except for Lightroom raw files, which are 
saved as PSDs.

• Color Space: Determines what RGB working color space is used; Adobe RGB 1998, sRGB or 
ProPhoto RGB.

• Bit Depth: Sets the file bit depth, either 8-bit or 16-bit per pixel.

• Resolution: The resolution drop-down menu determines the resolution of the file.

• Stack with Original: When enabled, the new image is stacked with the original image, making it 
easier to organize.

• Use Original for Single PSDs: When enabled, if you select a single PSD file, it will be edited 
directly, rather than having a copy made.
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SYSTEM

The System tab is where you change the 
performance-related characteristics of ON1 
Resize 2018.

Memory Usage

• System Usage: Specifies the amount 
of system memory (RAM) that is used 
by the application. The maximum (and 
default value) is 80%.

• VRAM Usage: Specifies the amount of 
video memory (VRAM) that is used 
by the application. The maximum (and 
default value) is 80%.

Scratch Folder Location

This setting lets you move or reset your memory cache, which helps speed many editing operations while 
you’re running ON1 Resize 2018. This is helpful if your system drive has limited space and wish to use a 
different—or faster—external drive as a cache. This cache information is purged each time you quit the 
application.

Browse Cache

ON1 Resize 2018 stores thumbnails previews on disk so that the next time you browse a folder it loads 
much faster. This setting lets you adjust the memory cache size or amount of information stored, empty the 
cache, move it to another location, or reset it if you are having issues with Browse. 

NOTE: If you have a small solid-state drive as your boot volume, you should 
move your cache to another drive, since the Browse cache can take up a lot of 
space when you are using cataloged folders.

Performance (Fast panning)

Fast panning is available when you’re viewing an image at 100% in Detail view, and is designed to give you 
better performance when using the Hand tool to pan around the image, With this setting on, as you pan, 
Resize will display the image at a lower quality; as soon as you let go of the mouse, the app will then show 
the pixels at their highest quality.
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SERVICES

This tab controls which online storage services 
are displayed in the Sources pane in Browse. 
Currently, ON1 Resize 2018 supports Dropbox, 
Google Drive, and Microsoft OneDrive. Resize 
2018 will automatically add any of the services 
if finds them on your computer during the 
installation process, but if you add (or remove) 
any of these services later, use this tab to 
manage them.

ON1 PHOTO FOR MOBILE

ON1 Photo for Mobile uses your Dropbox or 
Google Drive account to publish photos from 
your computer to your iOS devices. (Published 
photos are visible via the ON1 Mobile app, 
which is available for free in the iOS App Store.) 
To configure ON1 Mobile on your computer, 
choose the service you wish to use—Dropbox or 
Google—and sign in via the button in this tab.

The image size option lets you choose standard 
or double-size versions of your synced photos.

Further information about ON1 Photo for 
Mobile is available starting on page 32, and 
on the ON1 website.
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BASIC COMMANDS MAC OS WINDOWS
Cut Command X Control X

Copy Command C Control C

Paste Command V Control V

Undo Command Z Control Z

Redo Command Shift Z Control Shift Z

Print Command P Control P

Browse Folder Command B Control B

Select All Command A Control A

Select None Command D Control D

Deselect / /

Quick Export Command Shift S Control Shift S

Rotate 90° Clockwise Command ] Control ]

Rotate 90° Counter Clockwise Command [ Control [

Search Text Command F Control F

Navigate Browser Selection Arrow keys Arrow keys

PANEL COMMANDS MAC OS WINDOWS
Show/Hide Browser (Left) Panel Command Left Arrow Control Left Arrow

Show/Hide Control (Right) Panel Command Right Arrow Control Right Arrow

Show/Hide All Panels Tab Tab

Show Navigator/Histogram/Info Command 1 Control 1

Folders Pane Command 2 Control 2

Albums Pane Command 3 Control 3

Filters Pane Command 4 Control 4

Recent Pane Command 5 Control 5

Info Pane Command 6 Control 6

Metadata Pane Command 7 Control 7

Enable Filters Command L Control L

ON1 PHOTO RAW 2018 KEYBOARD SHORTCUTS
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TOOL & EDITING COMMANDS MAC OS WINDOWS
Rate Photos (Browse) Number keys 1-5 (1 to 5 

stars)

` (backquote key) no stars

Number keys 1-5 (1 to 5 stars)

` (backquote key) no stars

Set Color Labels (Browse) Number keys 6-0 (red, 
yellow, green, blue, purple)

Number keys 6-0 (red, yellow, 
green, blue, purple

Set Likes (Browse) P (like)

U (clear like)

X (dislike)

P (like)

U (clear like)

X (dislike)

Delete Photo (Browse) Delete Delete

VIEW COMMANDS MAC OS WINDOWS
Toggle Preview \ \

Zoom In Command + Control +

Zoom Out Command – Control –

View Actual Pixels Command Option 0 Control Alt 0

Fit to Screen Command 0 Control 0

Full Screen Mode Command Control F F11

Detail View E E

Filmstrip View F F

Grid View (Browse only) G G

Compare View (Browse only) C C

Increase Thumbnail Size + +

Decrease Thumbnail Size - -

Preview Area Compare Command Y Control Y

Show Quick View Browser Option Up Arrow Option Up Arrow
Go From Grid to Detail (Browse) Spacebar Spacebar
Go from Fit to 100% View Spacebar Spacebar
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PART 2: ON1 BROWSE
ON1 Resize 2018’s Browse module is a powerful and incredibly fast photo browser and manager. It gives 
you one place to find, view and manage your images, no matter where they are located.

Browse is an ideal environment for performing quick sorts and edits after a shoot: You can import, then 
view, your photos immediately without having to wait for a long cataloging or preview-creation process. 
You can rate, add keywords and flags, even remove photos, all from within Browse.

But Browse also has a sophisticated indexing system built in, designed to let you get access to your favorite 
folders of images in a jiffy; just add a folder to the Cataloged Folder pane, and it will index your photos in 
the background wherever they reside, giving you increased search capabilities and even faster access to 
your most important photos.

Some of Browse’s key features:

• Find your photos fast, wherever they are: local drives, network drives, or online storage 
services (Dropbox, Google Drive, Microsoft OneDrive).

• Catalog most-used folders of photos to get even faster access to your most important photos 
across multiple sources, while still preserving your folder hierarchies and locations.

• Multiple ways to view and cull images: Grid, Filmstrip, Detail and Compare views.

• Create quick albums from a selection of photos, or add simple and more-complicated smart 
albums across your entire library.

• Copy, move, delete and rename files.

• Sort, flag, rate or color code your images.

• Share photos with your mobile devices, and save mobile photos directly to ON1 Browse with 
ON1 Photo for Mobile.
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The Browse Workspace
The Browse module has three main sections: the Browse panel on the left side of the screen, the Preview 
window in the center, and the Photo Info panel on the right side.

The main components of Browse module include:

A.	Short Cuts: This palette contains shortcuts to your most common photo storage locations.

B.	 Preferences/Help icons: Accesses the ON1 Help menu or ON1 Resize 2018 preferences.

C.	 Browse Panel: The Browse panel contains file and photo management options.

D.	Folders Pane: Shows your cataloged folders, local disks and cloud sources.

E.	 Albums Pane: This pane allows you to create albums or collections of images.

F.	 Filters Pane: This pane allows you to sort and search your images and your favorites.

G.	Recent Pane: This keeps track of recently opened files and folders.

H.	View Selector: Switches between Grid, Detail, Filmstrip and Compare views.

I.	 Breadcrumbs: This shows the path of the selected image or folder in the Preview area.

J.	 Preview: The window where you can view your images in thumbnail or detail view.

K.	 Thumbnail Size/Sort Options: The slider adjusts the thumbnail size, while the Sort By pop up 
adjusts sort order based on standard selection criteria, such as file name, date captured and 
more. (You can also create your own custom sort order.)

L.	 Image Counter: This will display the number of files and folders you are viewing.

M.	RAW Preview Mode: Lets you set how you would like to view photos in Detail mode. Fast uses 
embedded previews from the photos; Accurate generates a color-balanced preview. 

N.	Info Pane: This section will give you detailed metadata about your image when available. 
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(Also displays Navigator and Histogram panes when viewing in Filmstrip, Detail and Compare 
modes.)

O.	Metadata Pane: This pane will show your metadata for your selected image.

P.	 EXIF/IPTC Info: Displays additional detailed information about your selected file.

Q.	Module Selector: Use this to switch to other modules inside ON1 Resize 2018.

R.	 Export/Share: Shortcuts for exporting and sharing selected photos. (See “Part 4: ON1 Export” 
on page 60 for more.)

Browse Panel
On the left side of the screen is the Browse panel. You can hide the panel completely by clicking on the 
Show/Hide Panel icons at the bottom left and right sides of the panel. (You can also use the Tab key to 
show and hide both the right and left panels simultaneously.)

The Browse panel consists of four panes—Folders, Albums, Filters, and Recent—which perform or display 
file-related activities.

TIP: Each pane can be collapsed by clicking in the pane’s title bar; a Hide/Show 
link is visible when you move your cursor over the title bar, but the entire title 
bar is clickable. 

FOLDERS

The Folders Pane is where you look for your photos. It contains a 
list of all disk drives, mounted drives, server shares, cloud storage 
services and mobile uploads on your computer. The Folders Pane has 
four components, Cataloged Folders, Local Drives, Cloud Storage 
and Mobile Uploads; clicking on an item in any of these sections will 
display the contents of that folder in the Preview area.

Cataloged Folders

A cataloged folder is a shortcut for your favorite or most-used 
folders of photos. A folder designated as cataloged is cached in 
the background to improve the speed of loading those folders (and 
subfolders) and their photos, making it ideal for portfolios, your best 
photos, or your primary library of photos.

Cataloged folders are also necessary for the following Browse 
features:

• For the creation of Smart Albums (see “Albums” on page 21);

The Folders pane is broken into four 
categories: Cataloged Folders, Local Drives, 
Cloud Storage, and Mobile Uploads.
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• For syncing photos to iOS devices with ON1 Photo for Mobile (See page 32);

• When using the Filters feature to search for photos across multiple folders.

You can make any available folder a cataloged folder by clicking on the ‘+’ button at the top of the 
Folders pane, or by dragging a folder from the Preview area onto the ‘Drop…’ button at the bottom of the 
Cataloged Folders section. The cataloging process is designed to work in the background, so it doesn’t 
affect other work you do in any ON1 Resize 2018 module. While the app is cataloging a folder, you’ll see a 
progress circle next to the folder name; once the folder has been cataloged, the circle will disappear.

To remove a cataloged folder, right-click on the folder name in the pane and choose “Remove Cataloged 
Folder.”

Local Drives

Browse automatically recognizes any disk (volume) inside or attached to your computer. This includes 
internal and external hard drives, optical drives, thumb drives, digital camera memory cards, digital 
cameras, any devices that support USB Mass Storage, and network-attached services (including mapped 
volumes on Windows).

Disks appear in the Folders pane under the Local Drives section with a hard drive icon next to them. Keep 
in mind that some disks, (like optical drives) are often read-only. You will be able to open a copy of a photo, 
but will be prompted to save the image to a new location.

Cloud Storage Services

Browse supports several common cloud storage services including Dropbox, Google Drive, and Microsoft 
OneDrive. All of these services—when you have them installed on your computer and other devices—keep 
local copies of your images on your computer, and Browse finds and monitors these locations automatically. 
If you edit an image stored in one of these locations they are automatically updated to the cloud.

During the installation process, ON1 Resize 2018 automatically looks for the default installation locations 
for these services. If you do not have one of these services installed, or you have it installed to a non-
standard location you will be asked to install or locate the folder when you click on the source. You can 
hide services you don’t use in the Preferences.

Mobile Uploads

If you use ON1 Mobile to synchronize photos from your phone with your 
computer, you will see a Mobile Uploads section at the bottom of the 
Folders pane, with the name of the device (or devices) listed. Clicking on 
the triangle will show you a list of the iOS albums shared; clicking on an 
album will display the synced photos. (For more about ON1 Mobile, see page 32.) 

Navigating Sources

To view the contents of any folder in the Folders pane, click on the triangle next to the folder name. This 
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will display the photos and subfolders within the selected folder inside the Preview area. To view the 
contents of a subfolder, either click on the subfolder inside the Folders pane, or double-click on it in the 
Preview area. (You can use the breadcrumbs bar at the top of the Preview area to navigate back to the top 
of your folder system.)

Using Short Cuts

The Short Cuts selector on the left side of the Browse panel is designed to take you to six specific 
locations and display their contents in the Preview window. From top to bottom, the icons 
represent your Desktop, your Pictures folder, cataloged folders, local drives, cloud sources, and 
albums. Clicking on one of the icons will change the view of the Preview window to the selected 
short cut.

Short cuts can be very useful when you have the Browse panel hidden to maximize viewing in the 
Preview window.

MANAGING FILES AND FOLDERS IN BROWSE

Deleting a folder

To delete a file or folder, click on it and press the Delete key or select ‘Delete’ from the right-click 
contextual menu. Then, confirm that you wish to move the file to the trash. If you have multiple files and or 
folders selected it will move them all to the trash. If you make a mistake you can use the Undo command, 
although some files or folders, like those on a network volume, must be deleted immediately and cannot be 
undone.

Renaming a file or folder

You can rename a file or folder by selecting it, then choosing 
‘Rename File’ from the right-click contextual menu. This will 
display a simple window where you can type in a new name for 
your image.

If you select multiple files, choosing the Rename Files from the 
contextual menu will give you additional options for the batch 
creation of new filenames. There are four fields:

• Current filename, which will use the file’s current 
name when renaming the file.

• Text, which lets you add any static text—a location, shoot name, etc.—to the filename.

• Serial number, which lets you sequence a group of images, starting with a specific number. You 
can use leading zeros to preserve filename sort order, and, you can start with any number. 

• Date, will automatically grab the image’s capture date and apply it to your new filename in any 
one of 12 different date formats. 

You can use any of the four fields, in any order and amount you wish; click on the ‘+’ button to add a new 

The Batch Rename dialog lets you create complex filenames 
for a group of selected images.
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field, and the ‘-’ button to remove one. As you work on your naming, a sample filename is displayed at the 
top of the window. 

Once you have your order set, click the Apply button to run the operation.

Creating a New Folder

You can create a new folder from the right-click contextual menu in the preview area or selecting Add 
Subfolder in the Edit menu. This will create a new folder inside the selected folder; if you have files selected 
in the preview area, you also will get the option to move or copy the selected images into the new folder.

Copying and Moving files and folders

You can copy and move files and folders in the ways you are accustomed to on your computer. You can 
select files and folders and use the Edit > Copy command to copy them to the clipboard and then Edit > 
Paste to paste them to new location, inside or outside of Browse. You can use this to copy a file or folder 
from one place to another or to attach an image to an email for example.

You can also use the familiar drag-and-drop functions to copy or move files and folders. Dragging and 
dropping a file or folder will move it if it is on the same drive or copy it to another drive. You can drag and 
drop in and out of Browse module.

Show in Finder/Show in Explorer

To view a file or folder in the Finder (Mac OS) or Explorer (Windows), right-click on an image or folder in the 
Preview area and choose Show in Finder or Show in Explorer from the pop-up menu.

ALBUMS

ON1 Resize 2018’s Albums feature lets you organize or keep track of 
photos on a project, event or even a broader category like a portfolio. 
Regular albums are created by selecting images manually and adding 
them to a new (or existing album) by dragging and dropping photos on 
the pane.

If you want to create albums that populate automatically based on 
criteria such as date, camera type, rating or more, you can use the Smart Albums feature.

Creating an Album

Click the + icon in the pane and choose Create Album… from the pop-up menu. 

You can also create an album by selecting photos and dragging them into the designated area at the bottom 
of the Albums pane.)

Adding Photos to an Existing Album
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There are multiple ways to add photos:

• Dragging and dropping a photo on the album name in the pane.

• Selecting a photo or group of photos, right-clicking on the current photo and choosing Add to 
Album from the pop-up menu.

• Choosing Album > Add to Album and picking the destination album from the menu.

• You can also copy a photo and paste it into an album: click on a photo, choose Edit > Copy, 
then click on the album in the Albums pane, and choose Edit > Paste.

Creating a Smart Album

Click the + icon and choose Create Smart Album… from the pop-up 
menu. A dialog box will appear, letting you choose the criteria for your 
album. These include:

• Ratings & Labels: Set the criteria for the album with like and 
dislike, star ratings and/or color labels.

• Date Range: Choose the time period in which the other criteria 
is eligible.

• Search: Create a custom search query based on metadata.

You can edit the Smart Album later by right clicking on the Smart Album 
in the pane and choosing Edit.

NOTE: Smart Albums will only search for photos residing in cataloged folders.

Delete an Album

To delete any album or smart album, just right-click on the album name and choose Delete.

FILTERS

The Filters pane allows you to find just the photos you want in your 
current folder or album. It will search for any photos that match the 
criteria you set, and has two modes: Simple and Advanced. In Simple 
mode, photos must match ALL of the set criteria to be found. The 
Advanced option lets you choose photos based on either any or all 
criteria, and can filter based on nearly every possible metadata type 
or textual information associated with a photo. To use the Filter pane 
in either mode, follow these steps:

1.	 Make sure you have the folder of images you wish to filter selected in the Folders pane.
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2.	 Click the Filters check mark to turn filtering on.

3.	 Set your filter criteria.

You can filter your photos in the Simple mode using the following options:

• Liked (represented by a heart filled in), disliked (X) or not set (empty heart). Click on the icon to 
turn that setting on.

• Star ratings from zero to five. Click on the greater than or equal symbol to the left of the stars 
to get a pop-up menu that lets you set the filter to show the exact number of stars, greater 
than or equal to the number of stars, or less than or equal the number of stars.

• Color labels.

• Date range: There are several preset relative date ranges or you can set your own defined date 
range by clicking on the pull-down menu.

• Text search: You can type into the search field to find images that contain the text in the 
filename, metadata, keywords or description.

• Search Cataloged Folders: This setting will apply the filter to all of your cataloged folders.

To filter with additional options, click on the Advanced triangle. 
There, you can add multiple conditions to search upon, and 
you can set those options to filter on any or all of the criteria 
selected. Create an advanced filter by performing the following 
steps:

1.	 Choose either Match All Criteria or Match Any 
Criteria from the pop-up menu directly under the 
Advanced tab.

2.	 By default, the pop-up underneath the Match menu 
is set to Everything, with an empty text box to the 
right of the option. If you would like to narrow the 
filter to more precise metadata, click on the pop-up menu and choose one of the advanced 
options from the list. These options range from camera metadata (Camera, Lens, Focal 
Length, Aperture, Shutter Speed, and ISO), to descriptive metadata (Keyword, Author, 
Description); to image-specific information (File Path, File Type, Orientation, Height in Pixels, 
Width in Pixels); to object type (Version, Original, Video). One other filter, Time of Day, lets 
you select images based on the time they were taken; you can choose Morning, Afternoon, 
Evening, or Night.

3.	 Once you’ve selected a filter, click on field to the right of the filter and enter (or select) the 
information upon which you wish to filter. Many of the advanced filtering options have pre-
populated data taken from indexed metadata in your library, while others let you enter text 
into the selection field. For example, when choosing the Camera filter you will see a list of 
cameras that you have used, but when you use the Description filter, you can enter any text 
you wish to search for in the current view. (The Everything filter looks for text in all of the 
metadata associated with your photos.)

4.	 To choose additional filtering options, click on the Add button at the bottom of the Filter 
pane, and choose another criterion from the pop-up. 
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RECENT

The Recent pane keeps track of recently opened files or manually 
browsed folders. Files are listed in order of last opened. You can access 
your most recent files in this pane by clicking on the one you want and it 
will appear in your main preview window. The Recent pane only shows 
files you have opened from within ON1 Resize 2018, not files you have 
opened from Lightroom, Photoshop, or Photoshop Elements.

You can clear the recent file list by pressing the ‘x’ icon in the title bar.

PREVIEW AREA

The Preview window is the largest part of the Browse workspace. Here, you can view folders of images 
in either thumbnail or detail view, based on the folders, albums or filters you have chosen via the Browse 
panel. There are four main views in the Preview window:

• Grid, which displays a grid of thumbnails of your images. This view also displays folders, 
letting you go up and down a folder hierarchy quickly.

• Detail, which you get by double-clicking on a thumbnail. You can view this image in either ‘fit 
to window’ view, or can zoom in to see more detail.

• Filmstrip, which displays a strip of images from a folder or album at the bottom of the screen. 
The currently selected image displays in the preview area above the strip; use the arrow keys 
to move through the folder, or click on an image in the filmstrip to view it in the preview area.

• Compare, which lets you view a group of photos in separate panes inside the preview area. 
You can zoom in on one or all of the selection, and lock the panning so that, as you move 
around one photo, the others move with it. Using Compare, you can quickly find the best 
images in a sequence, whether it be for composition, sharpness, facial expressions or more.

You can change the viewing mode between Grid, Filmstrip, Compare and Detail views by clicking on the 
view selector at the bottom of the window, or by using the keyboard shortcuts (G, F, C and E, respectively).

Fast Preview mode

Sometimes, when you get back to your computer after a shoot, you want to be able to go through a large 
number of photos quickly, looking for your best shots. ON1 Resize’s Fast Preview mode lets you do just 
that. Simply choose Fast from the RAW Previews pop-up at the bottom of the Browse window, and you can 
jump from photo to photo quickly with minimal lag between shots.

If you are more concerned about color accuracy than speedy previews, select Accurate from the RAW 
Previews pop-up. ON1 Resize will generate a full-resolution preview of your photo, using the photo’s 
embedded color profile. This will take a few seconds, depending upon the size of the raw file you’re 
working with, but you will get a better sense of the actual color in the photo.
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Persistent Thumbnail Cache

When you go through a folder of photos, Browse caches thumbnails and preview images as well as 
extracted metadata. This will make it faster the second time a user browses a folder. It also stores 
user-added or adjusted metadata such as ratings, labels, keywords, captions, rotation and GPS data, 
among others. (You can adjust the size of the cache and change the storage location of the cache in the 
Performance tab in ON1 Resize 2018‘s Preferences window.)

WORKING IN GRID VIEW
Grid view displays thumbnails of folders 
and images you have selected using the 
Folder or Albums panes. There are many 
operations you can perform from inside 
Grid view, including:

• Use the breadcrumbs to navigate 
(the ‘<’ button goes up one folder).

• Select your image while in Grid 
view and open the photo in one 
of the editing modules.

• Adjust the size of the thumbnails 
using the slider at the bottom of 
the screen or use “-/+” keys on your keyboard.

• Check Show Sub-Folder Contents when you want to view all folders (this only works when 
you are viewing cataloged folders).

Sorting photos in Grid view

When working in Grid view, you can sort the 
thumbnails in a number of different ways by 
choosing the Sort By pop-up at the bottom of 
the window. The sorting options include: date 
captured or modified; color label; file name, 
type, or size; and rating. 

You can also create a custom sort order by 
dragging thumbnails inside the grid window; 
click and drag the thumbnail so that the outline 
sits between two other images, then let go. 

Once you change the order of images this way, 
the Sort pop-up will change to Custom, and 
Resize will remember the sort order for that 
folder until you change it. (Custom sorting also works—and the custom order remembered—when you’re 
viewing albums.)

Grid view (with side panels hidden.

To reorder an image in Grid view, drag it between the two images where you want 
the image to be placed.
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At the bottom of the Sort pop-up are settings for sorting the view in ascending or descending order; 
selecting one of the options will rearrange the view accordingly. If you have a custom sort order, choosing 
these options will change the view in the opposite order.

WORKING IN DETAIL VIEW

In Detail View you can see a full-screen version 
of your photo. By default when you go to 
Detail View, your images will be displayed in 
Fit mode, showing the entire image. You can 
click on the image to zoom in to 100%. This is 
useful for judging small details and sharpness. 
Single-clicking on a image that is magnified will 
return back to Fit mode. You can click and drag 
a magnified image to look around. Your zoom 
mode is maintained as you move from image 
to image so you can compare the same spot in 
several frames.

In the Navigator pane you can reposition the 
preview and change the magnification amount.

In the footer you can view and adjust the Like, Star Rating and Color label for the current image.

When previewing images in Detail view, you can move to the next image by using the arrow keys on your 
keyboard.

WORKING IN FILMSTRIP VIEW

Filmstrip view is much like Detail view, presenting a large version of your currently selected image in the 
preview area (with all the viewing controls that are available in Detail view), and displaying other photos 
from the current folder in a strip of thumbnails 
at the bottom of the screen. The photos are 
sorted by the current sort order, which can be 
change via the Sort pop-up above the strip.

The current image will be represented by a blue 
rectangle in the filmstrip, and you can use the 
Left and Right arrow keys to move from photo 
to photo, or you can scroll with your mouse and 
click on a photo to display it in the preview.

When using Filmstrip view, the Navigator and 
Histogram panes are visible at the top of the 
Photo Panel.

In Detail view, you can zoom to 100% to check small details and sharpness in a 
photo, view its histogram, and even apply a preset, all without having to leave 
Browse.

Filmstrip view is similar to Detail view, but displays a strip of photos from the 
current folder (or album). You can easily move to another photo by using the right 
and left arrow keys, or by scrolling and clicking with your mouse.
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WORKING IN COMPARE VIEW

Compare mode is designed for those times 
when you shoot a sequence of photos of the 
same type of scene—from a portrait session, 
at a wedding, from a landscape series, for 
example—and wish to narrow that group down 
to find your best ones. With Compare, you 
can select a group of photos, view them side 
by side to check composition, zoom in on all of 
them simultaneously to check focus or facial 
expression, and rate your favorites and remove 
the rejects.

To use Compare mode, you can choose one of 
two methods:

• Select a group of images you wish to 
compare in either Grid or Filmstrip view. To select a group of contiguous photos (ones next 
to each other in order), simply click on the first one you wish to compare, then hold down 
the Shift key and click on the last photo. If you want to add noncontiguous photos, click on 
the first photo, then use the Command (Mac) or Control (Windows) key and click on each 
subsequent photo you wish to compare. When you have your selected photos, press the 
C key, or click on the Compare icon in the View Selector at the bottom left of the Browse 
window.

• You can also select photos directly in Compare mode: press the C key or click on the 
Compare icon in the View Selector at the bottom left of the Browse window. In the strip at 
the bottom of the window, you can select the photos in the same manner as the first option, 
by clicking on the first photo in a sequence, and Shift-clicking on the last, or by using the 
Command (Mac) or Control (Windows) key to select noncontiguous photos from a group.

When you enter Compare, you will see your selected photos in a grid in the Preview area, fit to show the 
entire photo. The currently selected photo will have a blue box around it, while the other items in the 
selection will have a light gray box around them. You can switch the primary selection by using the arrow 
keys on your keyboard, or by clicking inside the pane you wish to make primary. 

If you click once inside the current selection, the photo will zoom in to show greater detail; if you click and 
hold the mouse button down, you can pan across or down your photo, so you can check for things like 
detail, sharpness or facial expressions. (Clicking a second time inside the pane will reduce the photo to fit all 
of it in the pane.) 

To see the detail across the group of selected photos, click on the Lock pan/zoom dot above the filmstrip. 
Now, when you click on an area inside the primary photo, all of the photos will zoom simultaneously to the 
same location of your click. And, if you click and drag inside the primary photo, all of the selected photos 
will pan along with the primary. To pan one photo—which can be useful if the field of view was different 
than the rest—click on that photo to make it the primary selection, then hold down the Shift key and click 
and drag inside that pane. If you do this and wish to get back to the original zoom position, click on the 
Sync button next to the Lock pan/zoom setting, and it will reset the zoom view to the same place in each 
compared photo.

Compare mode displays selected photos as panes inside the preview area. The 
photo highlighted with a blue box is the current selection. Clicking in that pane will 
zoom the photo; if the Lock pan/zoom box is checked (above the filmstrip), then all 
of the compared photos will zoom with it.
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Use the spacebar if at you want to zoom 
between fit and 100% on the selected photo in 
the grid. Toggling the spacebar between views 
does not “lock” and will not sync with other 
photos even if Lock is turned on.

If you wish to remove a photo from the group, 
select it (by clicking on it or by pressing the left 
or right arrow keys) and press the / (slash) key 
on your keyboard. The photo will be removed 
from the Compare window, and the remaining 
photos will resize to best fill the available space 
in the window. (You can also add additional 
photos to the Compare window by using the 
selection techniques mentioned above.)

When using Compare, you can rate or flag a photo, apply a preset and add other metadata. These functions 
will only be applied to the primary selected photo (outlined in blue). There is one exception to this: Using 
the Create Album or Add to Album commands from the Albums menu will add the currently selected 
photos to either the new album or to the chosen album. This feature can be helpful when you have a group 
of images that you would like to keep for a client or to further segment a series.

The Photo Panel
The panel on the right side contains information relative to the selected image in the Preview area.

INFO PANE (ALL VIEWS)

The Info Pane displays common metadata for the currently selected image in a large, easy-to-read format. 
This metadata includes:

• Camera make and model

• Lens focal length

• Capture date and time

• File type

• GPS

• ISO

• Shutter speed

• Aperture

• Exposure compensation

• Filename

• Color space

• Image dimensions and resolution

• File size

If any of the metadata fields are unavailable they will be left blank.

Zooming into a photo, and panning to the common areas of concern, you can 
easily determine which photo is sharp enough for your needs. You can then rate 
the selection and tag it as a favorite.
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GPS Metadata

If your image has GPS metadata embedded in it, the GPS button will appear in the Info pane. Clicking on 
this button will open the default web browser to Google Maps to the location where the image was taken.

THE NAVIGATOR PANE (DETAIL AND FILMSTRIP VIEWS ONLY)

This gives you a thumbnail view of your image. The white square 
region marks the image area that is visible in the preview pane. You can 
pan your image by clicking and dragging inside the square.

At the bottom of the Navigator pane are several zoom buttons 
representing percentage zoom views (100%, 50% and 25%). Click on 
one of the buttons to change the view. Fit zooms to fit the current 
canvas size, while 100 zooms to 100%, displaying the actual pixels.

THE LEVELS PANE (DETAIL AND FILMSTRIP VIEWS ONLY)

This gives you a color chart of the shadow, midtone and highlight areas 
based on an image’s RGB values (commonly known as a histogram). 
This is useful to show areas within the image that may be clipping. 
Clipping is when your image contains pure blacks or white and can 
signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while the 
right represents the highlights. At the top of each end is a triangle. 
If the triangle is lit, there is clipping on that side of the histogram. If 
you click on the arrows, you will activate the clipping overlay on your image, which displays the areas that 
are clipped. Those areas with a blue overlay are pure black, while the areas with the red overlay are pure 
white. You can turn the clipping view off again by clicking on one of the triangles. You can also temporarily 
enable clipping view by holding down the J key at any time. (Clipping can be turned on or off permanently 
by pressing Alt (Windows) or Option (Mac) and the J key.) The clipping view is useful when you are making 
adjustments to the brightness and contrast of your image.

The Levels pane also displays the RGB values under the cursor at the bottom of the pane.

METADATA PANE

The Metadata pane provides more complete metadata than the Info pane about a photo, and lets you add 
your own metadata elements, such as copyright and contact information, keywords and photo descriptions. 
You can also view the complete EXIF data embedded in a photo by your camera, and add (or modify) 
comments and GPS coordinates to an image or group of images. ON1 Resize 2018 also supports the 
industry-standard IPTC metadata standard, which offers much more detailed metadata information and is 
used by journalists and stock photographers to catalog and tag photos.

To switch between the EXIF and IPTC fields, just click on the label. You can change the metadata in 
multiple images at the same time by selecting them all, then changing one or multiple fields in the pane.
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Metadata templates

With ON1 Resize, you can create metadata templates that apply 
common information to your images, data such as copyright, author, 
contact information, website and more. These preset templates can be 
accessed in the Metadata pane.

Saving a metadata template is easy: you can either go to an image that 
has the basic metadata items you wish to use, or you can select an image 
without metadata and add your common items to the Metadata pane. 
Once you have the metadata set, click on the Preset drop-down menu at 
the top of the pane and choose Save New Preset. The Save Preset dialog 
will appear on-screen, and you can choose which metadata fields you 
wish to save as part of the template. For example, while you might wish 
to save the copyright and contact information as part of your preset, you 
might not want to apply keyword, GPS or description data to a group of 
images. 

You can update a metadata template by selecting the preset in the pane, 
then changing the appropriate fields as desired, and then choosing 
Update Preset with Current Settings from the Preset drop-down. To 
delete a metadata preset, first choose the preset from the drop-down 
menu, then choose Delete Preset from the menu. 

Embedding Metadata

Metadata you add in Browse is stored in industry-standard 
XMP sidecar files for raw files. This facilitates the transfer of 
metadata to any application that supports XMP. When you edit an 
image, create a copy of an image for editing or use the ‘Send to’ 
command, the metadata is embedded into the file automatically 
(with the exception of raw files). You can manually embed your 
metadata into images using the Embed Metadata command from 
the Photos menu. This will open each image you have selected, 
update the metadata and re-save it. This is supported for TIF, 
PSD, PSB and JPG files; raw and PNG files do not support direct 
embedding of metadata.

Reading Metadata

Sometimes, when you’ve been sharing raw images across machines or with others, the metadata 
information might get ‘lost,’ or is different than your original metadata. In these instances, choose Read 
Metadata from the Photo menu, which will grab the metadata from the file or the XMP file (for raw files).

The Save Metadata Preset dialog lets you choose which 
metadata fields get saved to a preset from the currently 
selected image.
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Editing Photos in Browse
You can perform many basic culling tasks on photos inside Browse, including changing metadata, labels and 
ratings.

RATINGS, LABELS AND LIKES

Using a standard rating and label system, it is easy to sort and cull your favorites from the throw-away 
shots. Browse offers three ways, aside from keywords and subfolders, to mark and group similar images. All 
of these methods may be set several ways: from the Photo menu, the right-click contextual menu, clicking 
the badges on the image thumbnail or in the footer of Image view. There are also keyboard shortcuts 
associated with each classification option.

• Star ratings: Set from zero to five stars. Photographers often use five stars for their favorite 
images and one star for images they don’t want to keep, but you can use this system in 
whatever way works best for you. You can adjust the rating using the 1 through 5 keys on the 
keyboard. You can also clear the stars on any image with the ` (backquote or grave) key.

• Color labels: There are five color labels as well. Color labels are a great way to mark sub-sets 
of images for special handling. You can set the color ratings by pressing the following keys: 6 
(red), 7 (yellow), 8 (blue), 9 (green), 0 (purple).

• Likes: A common need for photographers is to mark their favorite images and the ones they 
want to delete. This is best accomplished with the Like classification. There are three options: 
Like (icon with a filled-in heart), Dislike (‘X’ icon) and Not Set (empty heart). By default, 
images are in the Not Set category until you change them. You can set your Liked images with 
the P keyboard shortcut, Dislikes with the X key, and clear settings with the U key.

Both star ratings and color labels are industry standards. When you use these tools, the settings are 
stored in the metadata and will be available in other photo editors and managers, like Lightroom. (Likes are 
proprietary and will only appear in ON1 Resize 2018.)

Use Auto Advance when culling your photos

ON1 Resize’s Auto Advance feature was designed to help you rank a group of images quickly: with Auto 
Advance turned on, when you apply a rating, color label or flag to an current image, Resize will make the 
change and automatically move to the next image.

Auto Advance can be turned on or off via the Photo menu.

SEND TO

ON1 Browse lets you send images you are viewing to other applications for editing. This is done via the 
Send to option, which is available from the right-click contextual menu or the Edit menu. ON1 Browse 
automatically detects the following common photo managers or editors and lists the latest installed version:
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• Adobe Photoshop

• Adobe Photoshop Lightroom

• Adobe Photoshop Elements

You can set up any application you want to send your photos to. Simply select the Send to Other 
Application option. Then select the application you want to send your photos to. The application will be 
remembered and listed with your other Send to options. (For example, if you use an email client you can 
add it to easily email photos.)

When you send an image to another application, you will be presented with the Edit in dialog box from 
ON1 Resize 2018. There you’ll have the option to send either the edited photo or the original, unedited 
image. If you choose to send a copy, you’ll have options for choosing the file type, color space, bit depth 
and resolution. If you use the same set of options every time, you can check the “Don’t ask me again” box in 
the window, and you won’t be prompted again. (To change this setting, go to the File pane in Photo 2018’s 
Preferences.)

ON1 Photo for Mobile
If you use either the Dropbox or Google Drive 
cloud service, you can sync selections of your 
photos between ON1 Resize 2018 and an iPhone or 
iPad with our iOS companion app, ON1 Photo for 
Mobile. You can organize a portfolio of your images 
for viewing on your iPhone or iPad, and can rate 
your images and have the ratings reapplied to the 
library on your computer. ON1 Photo also lets you 
automatically save photos from your iPhone or iPad 
camera roll directly to your computer.

To get started, click Configure Mobile from the 
Mobile menu in Browse, which opens the ON1 
Mobile Preferences window. If you already use Dropbox or Google Drive, choose the appropriate service, 
sign in, and give your computer a name. (If you do not have an existing account, Dropbox and Google offer 
free storage plans with 2GB and 15GB of data, respectively.)

PUBLISHING PHOTOS FROM RESIZE TO MOBILE

On your Mac or Windows computer, inside ON1 Resize:

• Create an album or smart album

• Right-click on the album name in the Album pane and choose Publish to ON1 Mobile. (You 
can also right-click on any cataloged folder and choose Publish to ON1 Mobile.)

In the background, ON1 Resize will upload JPG versions of the published photos to your chosen service. 
While the upload (or download sync) process is in progress, you’ll see a small circle icon next to the folder 
or album name in the Browse panel. When the upload is complete, the icon will change to a phone with a 
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checkmark over it. (The published albums or folders are also 
displayed at the bottom of the Mobile menu in Browse.)

After ON1 Photo for Mobile is set up on both your computer 
and your iPhone or iPad, any changes you make to ratings or 
flags on your iOS device will be updated in those photos the 
next time you launch ON1 Resize.

To remove a published album or folder from ON1 Photo for 
Mobile, right-click on the album or folder you wish to remove, 
and choose Unpublish from Mobile from the pop-up menu. To 
remove all of your published photos, choose Configure Mobile 
from the Mobile menu. In the Preferences window, click on the Reset ON1 Photo for Mobile button. This 
will remove all of the photos from your service and the associated database files that are linked to them. 
This will not affect any of the photos on your computer.

USING ON1 PHOTO ON YOUR IPHONE OR IPAD

To use ON1 Photo for Mobile, you must first install the app on your 
iOS device:

• Open the App Store

• Search for “ON1 Photo”

• Click on the Get button, then choose Install

• Sign in using the same credentials you supplied with the 
Desktop configuration (Google Drive or Dropbox)

Once your published photos have been uploaded, and you have signed 
into ON1 Photo on your iPhone or iPad, you will see a grid of your 
published photos. Clicking on one of the photos in the grid will display 
that photo full-screen; you can use standard iOS swipe, tap and pinch 
gestures to move between photos, zoom in and return to the grid.

If you scroll through the grid, a slider will appear on the right side of 
the screen. Clicking on that slider and dragging up or down will scroll 
faster through your library. As you drag, a label will appear to the left 
of the slider, with the date of the photos in that group. 

In detail view, you can see any ratings information you have applied to 
the photo, and any changes you make here will be synced back to your 
photo the next time that you launch ON1 Resize. 

You can also use the standard iOS Share options by clicking one of the buttons on the bottom left side of 
the screen, and can share a photo directly to Instagram by clicking on the Instagram icon at the bottom of 
the screen as well.

When viewing a photo, if you swipe up from the bottom of the ON1 Photo screen, you will see additional 
metadata associated with your photo, including date taken, camera info, and the keywords or collections 
(albums) that the photo is part of. Clicking on a keyword or collection name will filter all of the photos in the 

When you’ve successfully published an album or cataloged 
folder to ON1 Mobile, you’ll see a phone icon next to the 
album name.

ON1 Mobile’s default grid view displays all of 
the photos you’ve shared from your computer.
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current image group to just those with that selection.

By default, ON1 Photo for Mobile displays all of the photos you have 
published via ON1 Resize; to view the individual folders or albums, 
click on the ON1 logo to display the Settings panel of the app. There, 
you can view specific folders or albums (called collections inside 
ON1 Photo for Mobile) by selecting the appropriate item in the list. 
(The grid will then include the album or folder name at the top of the 
screen.)

SHARING CAMERA ROLL PHOTOS WITH ON1 
PHOTO FOR MOBILE

You can set ON1 Photo for Mobile to automatically capture new 
photos shot with your camera, as well as specific albums. 

To set this up, click on the ON1 icon at the top left of the ON1 Photo 
screen. This will open a drawer with two options, Folders and Settings; 
click on the Settings icon to display the basic settings for the app. 

Next, tap on the Mobile Uploads section of the drawer, which will 
display a list of all the albums you have set up on your phone. If you 
want to have all of your photos synced, tap on the All Photos album. 
If you want to just share specific albums—which can be helpful if you 
don’t want to have every photo automatically synced—tap on the 
album (or albums) you wish to share.

Once you set the albums you wish 
to sync, ON1 Photo for Mobile 
will grab and sync the last 20 
photos from your camera roll, and 
whenever you launch the app, it 
will copy those albums’ photos into 
your ON1 Photo library and sync 
them with your cloud service. If you 
would like ON1 Photo to update 
its library in the background, go 
to the iOS Settings app and tap on 
the Privacy setting, then choose 
Location Services. Scroll down 
until you find ON1 Photo and tap 
it. Choose Always from the options 
and close the Settings app.

For more on ON1 Photo for Mobile, 
click on the Help Desk item in ON1 
Photo’s Settings panel; that will take 
you to the ON1 website, where you 
can view frequently asked questions 
about ON1 Photo for Mobile.

Tapping on a photo in Grid view will display the 
photo full-screen. You can slide the bottom 
pane up to see the photo’s metadata, and 
tapping on keywords or collection names will 
display photos in your catalog that match those 
conditions.

To share your phone’s camera roll pictures, first click on the ON1 icon at the top of the screen, and 
click on the Settings icon. Then, click on Selected Albums. In that screen, you can choose to add all 
your photos to ON1 Mobile, or you can choose different albums to sync. The next time that you 
launch ON1 Resize 2018 on your computer, your phone photos will appear in the Mobile Downloads 
section Browse’s Folders panel.
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Browse menus
ON1 Resize (Mac OS Only)

• About ON1 Resize 2018: Opens the about box, 
displays your version number. (This is in the Help 
menu on Windows)

• Preferences: Opens the preferences dialog. (This 
option is in the Edit menu on Windows)

• Quit ON1 Resize 2018: Quits ON1 Resize 2018.

File Menu

• Browse Folder: Opens the browse dialog where you 
can select which folder you would like to browse.

• Browse Home: Navigates to your home Pictures 
folder.

• Browse Desktop: Navigates to your desktop.

• Add Cataloged Folder: Lets you choose a folder to 
add to the Cataloged Folders section of the Folders 
pane.

• Remove Cataloged Folder: Removes the selected 
folder from the Cataloged Folders pane.

• Manage Extras: Opens the Extras Manager where 
you can import and manage extras like Borders, 
Backgrounds, Textures and Presets.

• Quick Export: Saves the current image in Photoshop, 
TIFF, JPEG or PNG format.

• Edit in ON1 Resize: Launches the Resize module with 
the currently selected image.

• Send to (list): Sends your image to the selected 
application in the list (the list varies by system).

• Export: Opens the export side panel.

• Print: Opens up the print dialog box.
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Edit Menu

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only 
available if the last thing you did was an undo.

• Select All: Selects all the images in the current 
folder.

• Select None: Deselects all the images in the current 
folder.

• Deselect: Deselects the current item.

• Copy: Copies the currently selected items.

• Paste: Pastes the items in the clipboard to the current 
location.

• Rename Files: Renames the selected file or folder.

• Delete: Moves the selected files and/or folders to the 
trash.

• Add Subfolder: Adds a new empty subfolder inside the 
current selected folder.

Album Menu

• Create Album: Creates a new Album.

• Create Smart Album: Creates a new Smart Album.

• Rename Album: Renames selected Album.

• Delete Album: Deletes selected Album.

• Add to Album: Add selected photos to available 
Albums.

• Remove from album: Removes selected photo(s) from 
Album.
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Photo Menu

• Color: Sets the color rating of a photo (None, Red, 
Yellow, Green, Red, Purple)

• Rating: Sets star rating (0 to 5 stars)

• Like: Sets a photo to Like, Reject or Not Set

• Auto Advance: When checked, any color, rating or like 
setting applied to a photo will save it for that photo, 
then move on to the following photo.

• Rotate 90 Degrees CW: Rotates an image clockwise by 
90°

• Rotate 90 Degrees CCW: Rotates an image 
counterclockwise by 90°

• Edit Capture Date: Let’s you adjust the date captured 
metadata, including a setting to take account for time 
zone changes.

• Embed Metadata: Stores adjusted metadata to a selected 
file. (Only applicable to certain file formats.)

• Read Metadata from Photo: Reads the embedded 
metadata from a raw file, overwriting any data that 
might be in the XMP sidecar files. (Useful for times 
when the metadata appears out of sync with different 
apps.)

• Save Metadata Preset: Lets you save some or all of the 
current image’s metadata fields as a preset.

• Delete Metadata Preset: Lets you delete a saved 
metadata preset.

Mobile

• Configure Mobile: Sets up ON1 Photo for Mobile 
sharing services via the Mobile Preferences window.

• Pause/Resume Publishing: Lets you pause and restart 
the publishing of photos to ON1 Mobile service.
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View Menu

• Bigger Thumbnails: Increases the size of the 
thumbnails in Grid view.

• Smaller Thumbnails: Decreases the size of 
thumbnails.

• Zoom In: Zooms into your image in Detail, Filmstrip 
or Compare view, displaying more detail.

• Zoom Out: Zooms out, fitting more of your image in 
the window.

• Fit to Screen: Resizes your image on-screen, to fit it 
entirely in the preview window.

• Actual Pixels: Zooms in to the 100% view of your 
image.

• Square Thumbnails: Changes your thumbs to square.

• Always Show Filename: Keeps the filename label 
turned on in the thumbnails while in Grid view.

• Enable Filters: Enables/Disables filter pane.

• Search Text: Places the cursor in the Filters search 
box.

• Filter by Label: Filters images by color.

• Filter by Rating: Filters images by star rating.

• Filter by Likes: Filters images by likes/dislikes.

• Reset Filters: Resets your filters.

• Sort: Sort by filename, date, rating, label and more.

• Sort Subfolders at the Top: When sorting, puts subfolders 
at the top of the grid.

• View Mode: Select from Thumbnail (grid), Photo (detail), 
Filmstrip or Compare views.

• Preview Background Color: Change the preview 
background color.

• Preset Browser Mode: Sets the Preset panel browser 
view to 1, 2 or 3 columns.
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Window Menu

• Minimize: Minimizes ON1 Resize 2018.

• Zoom: Zooms your window.

• Full Screen Mode: Enters or exits full-screen mode.

• Folders: Opens and hides the folders pane.

• Albums: Opens and hides the album pane.

• Filters: Opens and hides the filters pane.

• Recent: Opens and hides the recent pane.

• Info: Open and hides the info pane.

• Metadata: Open and hides the metadata pane.

• Show Browse Panel: Hides/reveals the Browse Panel.

• Show Photo Panel: Hides/reveals the Photo Panel.

• Hide Panels: Hides/reveals both left and right panels.

Help

• Search: Searches the menu options (Mac OS only).

• ON1 Resize 2018 Online Help: Opens ON1.com 
support page in your default web browser.

• Video Tutorials: Opens ON1.com product training 
page in your default web browser.

• Welcome to ON1 Resize 2018: Displays the Welcome 
window.

• Check for Updates: Checks with the ON1 update server 
to see if you are running the current version. 

• Sign-In/Sign-Out: Uses your ON1 account login 
information to authenticate (or deauthorize) your copy 
of ON1 Resize 2018

• Provide Feedback: Opens the default browser and 
navigates to the feedback page of the ON1 website.

• About ON1 Resize (Windows only): Opens the about box 
with the version number and license code displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 
support when you’re having issues with ON1 Resize 
2018.
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PART 3: ON1 RESIZE
ON1 Resize lets you get the highest quality photo enlargements, using the patented, industry-standard 
Genuine Fractals algorithms to enlarge photos without the loss of sharpness or detail. It includes the 
following features:

• Complete control over adjustment size and resolution

• Crop and level

• Sharpening

• Multiple resize algorithms let you get the highest quality results with any subject matter

• Add film grain

• Crop to common preset sizes for different paper and screen sizes

• Add gallery wrap wings for printing on canvas

• Divide an image into tiles for printing mosaics or murals

• Crop, resize, and print all in one place without having to create a new file

• Hundreds of presets to create the desired size print and adjust options for your printer and 
paper combination

When Should I Use ON1 Resize?
ON1 Resize should be used as one of the last steps in your workflow before printing. The power of ON1 
Resize is in the concept of resolution on demand. You can work with a modest size file, which makes your 
editing faster and takes less hard drive space and memory. Then when you are ready to output your file, 
you resize it with ON1 Resize to the desired size and sharpen it for output. This means you don’t have to 
keep multiple versions of a file at different print sizes; you just create what you need on-the-fly. ON1 Resize 
also supports layered Photoshop files so you can maintain all your layers in the entire process.

NOTE: A much fuller discussion of resolution and print size can be found in 
the “How Big Can I Print?” and “How Much Resolution Do I Need?” sections at 
the end of this chapter, starting on page 52.
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The Resize Workspace
ON1 Resize provides you with an easy-to-use work area for editing your photos. Below is an overview of 
the main sections, including:

A.	Presets: This panel is located on the left side of the window and is where you view a Library 
of presets.

B.	 Tool Well: This is where the tools are located.

C.	 Settings/Help: This is where you can access preferences and help.

D.	Search: This is where you can search for presets.

E.	 Preview Window: This is the main section where you preview and work on images.

F.	 Navigator/Loupe/Levels/Info Pane: This pane gives you access to each of the four areas.

G.	Pixel Dimensions: Displays the pixel dimensions of your resized image.

H.	Document Size: Displays the final document size.

I.	 Settings: Includes settings for different document types, resizing algorithm, and more. 

J.	 Sharpening: Apply sharpening type and amount, with highlights/shadows protection.

K.	 Film Grain: Controls the amount of simulated grain (noise) to your final image

L.	 Tiling: Divides your final image into pieces, letting you print on a smaller printer.

M.	 Gallery Wrap: Helps with creating a print for canvas, to account for stretching bars.

N.	Cancel/Done: Buttons to cancel your session or save and close your image.

O.	Export/Share: Options for exporting or sharing your image.
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Navigating the Preview
The Preview Window above is the main section where you preview and work on images. Resize includes 
two tools for navigating this window, the Zoom and Hand tools.

HAND TOOL

The Hand tool is used to position the image within the Preview window, whenever the preview zoom is 
larger than the viewable area.

To pan (scroll) in the Preview window:

• Select the Hand Tool and drag the image until you locate the area you wish to view.

• With any other tool selected, hold down the spacebar while you drag the image in the 
window.

• Double-click the Hand tool in the Tool well to set the image to a magnification that fits 
completely in the current window size.

ZOOM TOOL

The Zoom tool changes the magnification of the image in the Preview window.

With the Zoom tool selected:

• Click in the Preview window to zoom in and center the image at the location clicked.

• Click and drag in the Preview window to draw a rectangular, the screen fills with the area 
within the rectangle when you release the mouse.

• Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

• Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, 
showing every pixel. This is best when examining small details.

NAVIGATOR, LOUPE, LEVELS AND INFO

At the top of the control panel on the right of the main window are 
the Navigator, Loupe, Levels, and Info panes. These four panes can 
be useful for inspecting and viewing details in your image.

The Navigator Pane

This gives you a birds-eye view of your image. The white square 
region marks the image area that is visible in the preview pane. You 
can pan your image by clicking and dragging inside the white region.

The Navigator pane
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At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to activate.

• FIT: Zooms to fit the current canvas size.

• 100: Zooms to 100% or actual pixels.

• 50: Zooms to 50%

• 25: Zooms to 25%

The Loupe Pane

This gives you a magnified view of the section of the preview under 
the cursor. This allows you to view the quality of your results while 
maintaining a complete view of your image.

At the bottom of the Loupe Pane is a sliding for adjusting the zoom 
level.

The Levels Pane

This gives you a color chart of the shadow, mid-tone and highlight areas 
based on the image RGB values (often called a histogram). This is useful 
to show areas within the image that may be clipping. Clipping is when 
your image contains pure blacks or white and can signify loss of highlight 
or shadow detail.

The left side of the histogram represents the shadows, while the right 
represents the highlights. At the top of each end is a triangle. If the 
triangle is lit, there is clipping on that side of the histogram. If you click on the arrows, you will activate 
the clipping overlay on your image. The areas of your image with a blue overlay are pure black, while the 
areas with the red overlay are pure white. You can turn the clipping view off again by clicking on one of the 
triangles. You can also temporarily enable clipping view by holding down the J key at any time. The clipping 
view is useful when you are making adjusts to the brightness and contrast of your image.

The Levels pane also displays the RGB values under the cursor at the bottom of the pane.

The Info Pane

The info pane will display important metadata about your file including:

• Camera type

• File type

• Focal length and lens information

• Date and time captured

• Exposure information

• ISO

• Shutter Speed
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• Aperture

• Exposure Value

• Filename

• Color Space

• Dimensions

• File Size

If your camera allows for GPS the GPS button will be viewable and you can click on it to get the GPS 
coordinates for where the image was taken. This feature only works if you have GPS enabled on your 
camera or mobile device. Otherwise you will not see the GPS button.

CROP TOOL

The Crop tool is used to crop and resize the entire image. Resize’s Crop 
tool removes any pixels outside a crop box and changes the canvas size 
at the same time.

To crop the image, select the Crop Tool from the tool well. Then adjust 
the corner handles of the crop tool overlay. The area outside the crop 
box appears darkened for guidance. You can resize and move the image 
inside the crop box. When you are satisfied with your settings, press the 
Apply button in the Tool Options Bar or press enter.

Working with the Crop Tool Overlay

• Moving the Image: To move the image inside the crop box, 
simply click and drag inside the box. You can also nudge the 
image using the arrow keys on your keyboard.

• Resizing a Crop Box: To resize the Crop Box, click and drag on any of the resize handles. 
Clicking on a corner handle allows you to adjust two sides at the same time. Clicking on a side 
handle allows you to adjust that side. If you hold the shift key down while adjusting the size, 
the proportions of the box are maintained. To rotate the crop box, move outside a corner 
until the tool changes to rotate. You can also set the aspect ratio or size of the crop box in the 
Tool Options bar.

NOTE: The Crop tool is not available when using a Smart Photo, or when you 
are using ON1 Resize 2018 as a plug-in from Photoshop, Lightroom or Apple 
Photos.

Crop Overlay
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Crop Tool Options Bar

• Preset pop-up: Pop-up controls the crop tool mode as well as aspect ratio and document size 
presets.

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

• Height: Sets the height of the crop box.

• Units: Determines the unit of measure (pixels, inches, centimeters, millimeters, percent).

• Leveling Tool: Click and drag this tool across an element in your image that should be level.

• Angle: See and adjust the angle of rotation.

• Rotate: Rotates the image 90 degrees.

• Cancel: Resets the crop tool.

• Apply: Applies the crop and resizes your photo.

Crop Tool Modes

The Crop Tool works in three modes, which are all accessible via the Preset pop-up 
in the Tool Options bar:

• Freeform: In this mode you can adjust the crop box any way you like. The 
image will not be resized. Any area outside the crop box will be trimmed 
off. Use this mode if you just want to change the shape or recompose your 
image for general use.

• Aspect Ratio: You can lock the crop box to an aspect ratio. This makes sure 
the crop box shape doesn’t change, just the size. Use this option to trim 
existing pixels while maintaining a ratio without resizing the image.

• Document Size Presets: Document Size Presets allow you to crop and resize 
your image at the same time. If you know your intent is to print the image 
at a certain size you can crop and resize the image at the same time. Many 
common sizes are included plus you can create your own.

Leveling the Image

The Crop Tool has a special Leveling Tool for automatically rotating your image to be level. To access it, first 
select the Crop tool, then perform the following:

• Select the Leveling Tool from the Crop Tool Options Bar. Your cursor will change to the 
Leveling Tool.

• Click and drag a line across your image that should be level, either horizontally or vertically. 
When you release the mouse the image will be rotated automatically to the correct angle.

Crop Tool modes, 
accessed via the Presets 
pop-up in the Tool 
Options bar.
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ADJUSTING THE IMAGE SIZE

In ON1 Resize, you can adjust your image size using either the 
Document Size pane or the Crop Tool Options Bar. The information 
in these areas are interrelated and locked together. Adjusting the 
values in either pane will lead to changes in the other pane.

In the Document Size pane it displays the current desired Document 
Size or the original image size if you have not adjusted anything. 
You can simply type into the Width or Height fields to change the 
Document Size.

Keep in mind that the Width and Height fields are locked together to maintain the photo proportions. 
Changing the width will change the height proportionally. Resize does not support non-proportional scaling. 
If you would like to change the proportions of the image it requires cropping, so use the crop tool.

The Document Size Presets make it easy to crop and resize your photo at the same time. Simply select one 
to set the width and height automatically. This also selects the Crop Tool so you can adjust the document 
size to fit your photo. You also control your resolution, known as pixels per inch or dots per inch. This is 
important to adjust based on your output device.

The Pixel Dimensions pane displays the flattened, uncompressed image size in pixels as well as the file size, 
bit-depth and scaling factor.

Using Document Size Presets

Document size presets allows you to crop and resize your image simultaneously. Often, when you are using 
ON1 Resize it is to create a file for print output at a known common size. In these cases, using a Document 
Size Preset can be the fastest way to set your Document Size and crop your image to the needed 
proportions.

Follow these instructions to use a Document Size Preset:

1.	 Select your desired size from the Document Size preset 
pull-down in the Document Size pane, or Crop Tool Options 
Bar. You will see that the Document Size fields will be 
completed automatically for you and that a crop box is 
drawn on your image matching the proportions of the 
document size preset that you selected.

2.	 If needed, select the rotate crop box to rotate your crop 
box to the proper orientation. It will automatically rotate to match the orientation of your 
image, but if you want to crop differently you may need to rotate it.

3.	 Now, you can use the crop tool to reposition and change the size of the crop box so that 
it contains just the image area that you want. Note that the crop box proportions and 
Document Size are locked so that you will always have the finished document size that you 
requested.

4.	 Adjust your resolution to what is needed for your output device. If you are unsure what to 
select, use the resolution drop-down menu for common settings.
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Resize comes with many commonly used print, paper and video document size presets but you can also 
create your own:

• Select your image and launch Resize.

• From the Document Size Preset pull-down, select Custom > Manage Custom Sizes.

• Click on the Add button.

• Double-click on the highlighted untitled name and name your preset.

• Double-click on the width and height and fill in the proper values.

• Click on the units and select the proper unit.

• Click on the OK button.

TIP: If you select the incorrect Document Size Preset you can change it by 
selecting a different one. If you do not wish to use a Document Size Preset 
after you have selected one you can press the Reset button in the Document 
Size pane or the Cancel button in the Crop Tool Options Bar.

TIP: The lock crop option locks the proportions and document size settings for 
the given crop. This is on by default when you use a Document Size Preset.

SETTINGS PANE

The Settings pane contains the controls for selecting the resizing 
method, or algorithm and its settings. Every image is different and 
selecting the correct settings here can improve the quality of the 
results. To help you get started, try one of the presets in the Image 
Type drop-down menu. This pop-up contains presets that adjust 
the settings for Amount and Threshold automatically.

Method

The Method drop-down selects the method, or algorithm, used to resize the image. The options are:

• Genuine Fractals: This is the classic, patented, fractal-based algorithm that has made Perfect 
Resize the standard for over a decade.

• ON1 Resize Portrait: This is a new variation on the Genuine Fractals algorithm designed for 
portrait images. It is slightly softer and does a better job representing skin and hair textures.

Texture

When you select the Genuine Fractals method there are several other controls—Texture, Threshold, and 
Smoothness—that tune the resizing algorithm based on the image. These all have to deal with the texture 
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of the image. If you were to analyze an image from a detail perspective you could break it into three 
categories: Edges, Continuous Tone and Textures.

Edges are the sharp details that define the edges of the subject in your image. It’s paramount that these be 
maintained in order for your enlargement to maintain quality.

Continuous tone areas—like skin or skies—are mostly solid or graduated color. These resize easily as there is 
little detail in these areas.

Texture, in Resize’s nomenclature, are the areas that fall between these two. They are areas that still 
contain detail but are not sharp edges. These are things like the surface of rocks, tree bark, fabric, animal 
fur, etc. The amount of detail in these texture areas can have a large impact on the perceived sharpness and 
quality of an image.

With ON1 Resize you can control the key algorithm variables that effect these areas. And, you can use 
presets for different image types and subject matters that help you get the best results in reproducing 
these textured areas.

Here’s how to think of the sliders in the Settings pane, as you adjust the look of an image:

• Texture: This controls the amount of detail in flat, non-edge areas of an image. If your image 
contains lots of small detail that does not have defined edges (many organic patterns like 
leaves, rock, bark; or man-made patterns like fabric) it may be good to increase the amount 
to a setting of 4 or 5. Settings beyond 5 will often introduce a bumpy noise pattern which 
is undesirable unless your original image was from scanned film. Settings lower than the 
default 3 are useful for images with large areas of continuous tone that have no appreciable 
detail (sand, snow, sky) but have hard edged foreground subjects such as landscape images, 
architecture or portraiture.

• Threshold: This controls the amount of hard edge detail that is enhanced. The default setting 
is 25. Decreasing the threshold will focus the algorithms only on edge information. This may 
be useful for portraiture or for reducing noise in your image. Settings higher than 25 will 
increase the amount of small detail in flatter areas of the image. Settings as high as 100 are 
useful for highly detailed images such as hair or feathers. Higher threshold settings will also 
make ON1 Resize process faster. A good way to start adjusting these controls is by setting 
the threshold to 100 and then move the amount up until the image is too noisy (bumpy) and 
then reduce the threshold to smooth out the noise in continuous tone areas. For detailed 
images with no little or no continuous tone, you might try the amount at 4 and the threshold 
at 100. For portrait images or images with significant JPG artifacts you should try an amount 
of 2-3 and threshold of 25 or lower.

• Smoothness: The smoothness slider is used to reduce artifacts along hard curved edges. Use 
the lowest setting needed.

TIP: Always make sure your zoom is set to 100% or 1:1 when adjusting the 
controls in the Texture Control Pane.
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SHARPENING PANE

The Sharpening pane contains the controls to add additional sharpness to your image.

ON1 Resize features three sharpening methods:

• Unsharp Mask: Good for general sharpening. Similar to 
Photoshop’s Unsharp Mask function. Resize’s sharpening 
is different in that it is only applied to the luminance of the 
image, to prevent color artifacts.

• High Pass: High Pass sharpening is helpful when the 
original image is not sharp.

• Progressive: Similar to Unsharp Mask, except it sharpens 
different amounts depending on the size of the details in 
the image. Small details are enhanced more than large ones.

Using the Sharpening controls can save you the workflow step of adding additional Sharpening before 
printing and can help compensate for loss of sharpness due to dot gain from your printer. Sharpening 
should only be applied at the end of your workflow just before printing. If you plan to do additional 
retouching or compositing work after resizing your image, you should disable the Sharpening controls.

To sharpen your image for output, use these steps after you have adjusted the Document Size pane 
controls:

1.	 Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset located in 
the Navigator pane.

2.	 Enable the Sharpening controls by toggling the on/off control in the Sharpening pane title 
bar.

3.	 Select the sharpening method that will provide the best results for your image. You may 
need to experiment to determine this.

4.	 Adjust the amount slider to determine the amount of sharpening desired.

5.	 Use the Highlight and Shadow sliders to limit the sharpening from being applied to the 
darkest and lightest areas of the image which can prevent sharpening of noise.
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FILM GRAIN PANE

The Film Grain setting controls the amount of simulated Film Grain 
(noise) to your image. Adding a modest amount of grain can make your 
image appear sharper visually and can help hide imperfections (such as 
JPG artifacts).

Adding film grain can be especially useful for monochrome images, and should be added just before 
printing. If you need to do other retouching or compositing work in Photoshop after resizing your image, 
you should disable the Film Grain controls in Resize.

To add Film Grain to your image follow these steps:

1.	 Zoom in on your image to 1:1. You can do this easily by using the 1:1 Zoom preset located in 
the Navigator pane.

2.	 Enable the Film Grain controls by toggling the on/off control in the Film Grain pane title bar.

3.	 Adjust the slider up or down until the desired amount of Film Grain is added.

You can preview just the effect of the Film Grain by toggling the on/off control in the pane’s title bar.

TILING PANE

The tiling feature in Resize divides an enlargement into smaller pieces so 
that the image can be printed on a smaller printer.

For example, you might want to create a mural that is 8 feet tall by 12 
feet wide, but your printer can only print 24-inch wide strips. With the 
tiling feature you could automatically create four separate files that are 
24 inches wide and 8 feet tall, to create your mural in sections.

With the tiling feature all you do is specify the size of paper you have to 
print on and if you would like the pages to overlap. Then ON1 Resize will resize your image and section it 
down into the individual tiles.

To use the Tiling pane, follow these instructions:

1.	 Turn Tiling on by toggling the on/off switch in 
the pane header.

2.	 Set the Width and Height fields to the size 
and orientation of paper that you wish to 
print on, or you can select the number of 
rows and columns instead.

3.	 Set the Overlap size. The overlap makes each 
tile overlap so you can tape multiple panels 
together and corrects for printer margins if 
you are not printing borderless. The Tiling Preview Overlay.
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4.	 Set the file type for the newly created files for each tile.

5.	 Set the destination folder for the new files. Each file will be named with the original filename 
and the tile indicated in the filename.

The preview will show cyan guide lines for each tile that will be created. The bottom of the Tiling pane will 
tell you how many tiles will be created.

GALLERY WRAP

The Gallery Wrap feature is designed to help you print on canvas. When 
making enlargements for canvas it is common to wrap a portion of 
the image around wooden stretcher bars. These can be several inches 
thick and are used for mounting the canvas. These are commonly called 
gallery wraps. However, if the photographer had important detail near 
the edges of the image they may be lost in the wrapping process. The 
Gallery Wrap feature in ON1 Resize automatically creates extended 
margins by reflecting or stretching the areas near the edge of the image 
allowing the photographer to create a gallery wrap without having to sacrifice any of the original image. 
The Gallery Wrap feature allows you to select the thickness of the canvas mounting bars and offers a 
variety of techniques for creating additional margins.

To use the Gallery Wrap feature follow these instructions:

1.	 Turn on the Gallery Wrap feature by toggling 
the on/off switch in the pane header.

2.	 Set the Thickness control to the amount of 
margins you would like to add. A good rule of 
thumb is the thickness of the stretcher bars, 
plus half an inch.

3.	 Select the Type you would like to use.

4.	 If you wish to add a color overlay to the gallery 
wrap wings set the color and opacity.

The Gallery Wrap feature has several settings for adding margins and adjusting the look of the wrap. The 
Type pop-up has four options:

• Reflect: Copies an area equal to the thickness setting around your image, then flips each side 
and adds it as the margins. This is a good general purpose technique.

• Reflect Soft: Does the same as the Reflect method but softens the added margins.

• Stretch: The Stretch method takes a small area around the edge of the image and stretches it 
to add the margins.

• Stretch Soft: Does the same as stretch, but softens the added margins.

The Thickness slider controls how thick your canvas stretcher bars are. Two inches generally works well for 
most gallery wraps.

The Gallery Wrap overlay shows you what your wrap will look 
like with the chosen settings. Here, the Reflect Type option is 
chosen.
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You can darken the wrap or add a solid color to the wrap area with the Overlay Color and Opacity sliders. 
(The Opacity’s default is 0, which means that there is no color overlay added.)

The Add to New Layer option places the wrap wings on their own layer, rather then merging them with the 
image. This only applies when working via Photoshop in a layered workflow.

PRESETS

Resize has a preset system built into it that is designed to help you get 
very specific crops for a wide range of paper and printer types. These 
include settings for photo lab print sizes, and many Epson, Canon and 
HP large-format printers, with Matte, Resin Coated, and Canvas types.

In addition to being able to set document size and settings, and 
settings in any of the other panes, Resize presets always contain a Crop 
adjustment. What that means is that any time you apply a preset, Resize 
selects the Crop tool and places the crop overlay on top of your file. 
There, you can move the overlay to the appropriate crop area (or resize 
the crop) for your photo.

To apply a preset, choose the category you would like to use from the 
Presets panel. The category will expand to a list of the available presets 
for that group. Then, just click on the preset you want to apply.

Saving a Preset

Once you have your settings that you wish to save, go to the Preset 
menu and select Save Preset, and choose a category you would like to 
save it in. If you have applied a preset to an image and make adjustments 
to any of the settings in the left panel, you can update that preset with 
the new setting by choosing Update Preset with Current Settings from 
the View menu.

To delete a preset, right-click on the preset in the Presets Browser and 
choose Delete Preset.

UNDERSTANDING RESIZE: HOW BIG CAN I PRINT?

People often ask how large a print can be made with ON1 Resize. If your original image is sharp, has good 
details and little noise, you could go as large as 1000% of the original size. 1000% is ten times the size of 
the original file. For example, an original file that is 8” x 10” could be resized to 80”x100”. Viewing distance 
plays a big part of this. Standard viewing distances are two-times the diagonal of a print. For example, for 
an 8”x10” it would be about two feet away. An 80”x100” would be about 21 feet. That seems like a lot 
but that image is almost 7’x9’. Keep in mind that many photographers scrutinize their images closer than 
standard viewing distances.

Images are perceived in color, tonality and sharpness. Other interpolation techniques maintain color and 
tonality but sacrifice sharpness by “inflating” the image uniformly. The image still looks familiar but will not 
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be crisp. Depending on the amount of interpolation, this can be severe and noticeable even at standard 
viewing distances. ON1 Resize maintains the color, tonality, and sharpness of an image at all sizes. It will 
always look the same when viewed at the proper distances.

It is unrealistic to assume that the fidelity when viewed at 100% will be the same for an 8×10 and an 
80×100 created by ON1 Resize. ON1 Resize will maintain the edges which perceptually make the image 
sharp, but it cannot create detail where there was none in the past. When the shutter is pressed, a finite 
amount of detail is captured. A good way to think about this is to look at an insect on a leaf. If you look at 
it with a magnifying glass, you will see more detail than you did than when looking at it with the naked eye. 
Now if you take a digital photograph of that same insect and look at it in the computer and zoom in past 
100% you do not see any more detail. The information you see is limited by what the camera captured. 
ON1 Resize works the same way, it cannot create new detail but instead takes the finite amount of detail 
available and increase it in size.

ON1 Resize isn’t magic. We have all watched CSI, where they take a security photo and enlarge the 
reflection in the victim’s eye to see the killer, with results that look amazing. This is science fiction. You 
cannot create detail where there was none before. But if your original file has good detail and little noise, 
you will be able to make very good looking enlargements from your files. This is what ON1 Resize does 
better than any other software.

HOW MUCH RESOLUTION DO I NEED?

To answer this, you need to know two things:

1.	 The size of the print you need to make.

2.	 The resolution that your printer needs for best results.

The size of the print is as large you would like. This may be limited by the size of your printer. Resolution 
is the density of the pixels for a given distance, usually measured in pixels or dots per inch. Most modern 
inkjet printers print anywhere from 1200 to 4800 dots per inch (what the printer manufacturers really 
mean is 1200-4800 droplets of ink per inch). Inkjet printers use many tiny round droplets of 4-12 ink colors 
to reproduce one square pixel in your image that could be one of any millions of colors. A common mistake 
is to set the resolution of the file to the resolution of the printer. In all but a few special printers this will 
lead to huge files that will not print well, if at all. The secret is that the human eye cannot see more than 
250-300 pixels per inch. So the ideal resolution for your files should be close to this. Once you know the 
print size and resolution, it is easy to use ON1 Resize to resize your file to the desired output. Simply input 
the resolution and then either the print width or height. You’ll see that the corresponding dimension is 
automatically filled in by ON1 Resize based on the proportions of your image.

Keep the proportions in mind because the proportions of film, digital camera sensors and paper can all be 
different. For example, most digital camera sensors are proportioned so that the height is two-thirds the 
width or 1:1.5; While the most common paper size, in the US, is the letter which is 8.5×11 inches or about 
1:1.25. These kind of proportion mis-matches are common and require that the original image be cropped 
to fit the proportions of the paper size. If your image cannot be cropped without ruining the composition 
then you will need to adjust your print size to a longer dimension.

Resizing an image larger than the original size requires new pixels to be created. This process is called 
interpolation or resampling. There are many mathematical ways, called algorithms, to do this. The most 



ON1 Resize 2018 User Guide	 Part 3: ON1 Resize	 54

common method used by many pixel editing applications is called bicubic interpolation. Bicubic along with 
its newer variants bicubic smoother and bicubic sharper work by averaging a small group of neighboring 
pixels to determine the color value of the new pixels to be added. While this technique is fast, it does not 
distinguish edges so there is a uniform loss of sharpness and detail across the image.

Resize’s patented scaling algorithm is fundamentally different from bicubic or other interpolation methods. 
While other methods sample nearby pixels and decide new pixel values one by one, ON1 Resize uses a 
sampling technique called Fractal Scaling. Fractal Scaling samples nearby “blocks,” square groups of pixels, 
and varying sizes, compares them to smaller versions of the original image and mosaics these patches 
together to create a larger version of the original. By doing this repeatedly, often the characteristics of the 
image like edges, smooth areas, and textures are reinforced for each larger version. Noise is de-emphasized 
and sharp details are maintained. All this number crunching may take a bit longer than the single pass 
interpolation methods like bicubic, but good things come to those who wait and the reward is far superior 
results.



ON1 Resize 2018 User Guide	 Part 3: ON1 Resize	 55

Resize Menus
ON1 Resize (Mac OS Only)

• About ON1 Resize: Opens the About box and displays 
your version number. (This is in the Help menu on 
Windows)

• Preferences: Opens the preferences dialog. (In the 
Edit menu on Windows)

• Quit ON1 Resize: Quits ON1 Resize 2018.

File Menu

• Done: Saves the current image and returns to 
Browse (or external source).

• Cancel: Cancels any Resize operations and returns to 
Browse (or external source).

• Export: Calls up the Export pane.

• Print: Opens up the print dialog box.

Edit Menu

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only 
available if the last thing you did was an undo.

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes (copies) the items in the clipboard to 
the current location.

• Reset All: Resets all of the settings.

• Preferences (Windows): Opens the Preferences dialog.

Preset Menu

• Save Preset: Saves the current Resize settings as a 
preset.

• Delete Preset: Deletes the currently selected preset.

• Edit Preset: Lets you rename a preset, choose 
a different category for it, and add metadata 
information (creator, description).

• Update Preset with Current Settings: If an image with a 



ON1 Resize 2018 User Guide	 Part 3: ON1 Resize	 56

preset applied has had some settings changed, this lets 
you update the preset to reflect those new settings.

• Import Preset: Imports ON1 preset (.onp) files.

• Show Presets: Opens the Presets folder on your 
computer.

• Manage Extras: Opens the Extras Manager window.

View Menu

• Zoom In: Zooms the preview window in one 
increment. This will make the preview image larger.

• Zoom Out: Zooms the preview window out one 
increment. This will make the preview images 
smaller.

• Fit to Screen: This sets the preview image so that the 
entire image is on screen at once. Think of this as an 
overview of the entire image. This is the setting you will 
use most of the time.

• Actual Pixels: This sets the preview image so that it 
zooms to actual pixels or 1:1 also called 100%. This 
setting allows you to see every pixel in the image. This 
is useful when making precision adjustments.

• Show Clipping: Shows the clipping overlay view, 
displaying the pure white or black pixels in the current 
image.

• Preview Background Color: Lets you set the background 
color options.

Window

• Minimize: Minimizes your screen.

• Zoom: Zooms your window to full-size (doesn’t hide 
menu bar).

• Full Screen: Toggles to and from full-screen mode 
(hides menu bar).

• Navigator/Loupe/Histogram: Hides or shows the 
Navigator, Loupe, Histogram (Levels) and Info pane.

• Pixel Dimensions: Opens or closes the Pixel 
Dimensions pane.

• Document Size: Opens or closes the Document Size 
pane.

• Settings: Opens or closes the Settings pane.

• Sharpening: Opens or closes the Sharpening pane.



ON1 Resize 2018 User Guide	 Part 3: ON1 Resize	 57

• Film Grain: Opens or closes the Film Grain pane.

• Tiling: Opens or closes the Tiling pane.

• Gallery Wrap: Opens or closes the Gallery Wrap pane.

• Solo Mode: When enabled, this feature keeps only one 
control pane open at a time.

• Show Control Panel: Hides or shows the Control Panel.

• Hide Panels: Hides or shows all Panels.

• Document Name: Shows the name, zoom level and bit 
depth of the open image.

Help

• Search: Searches the menu options (Mac OS only).

• ON1 Resize Online Help: Opens ON1.com support 
page in your default web browser.

• Video Tutorials: Opens ON1.com product training 
page in your default web browser.

• Welcome to ON1 Resize: Displays the Welcome window.

• Check for Updates: Checks with the ON1 update server 
to see if you are running the current version. If there 
is a newer version, you will be notified and be walked 
through the update process.

• Sign-In: Uses your ON1 account login information to 
authenticate your copy of ON1 Resize 2018. (Sign-out 
will remove an existing authentication.)

• Provide Feedback: Opens the default web browser and 
navigates to the feedback page of the ON1 website.

• About ON1 Resize (Windows Only): Opens the about box 
with the version number and license code displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 
support when you’re having issues with ON1 Resize 
2018.
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ACTION MAC OS WINDOWS
Print  Command P  Control P

Undo  Command Z  Control Z

Redo  Command Shift Z  Control Shift Z

Cut  Command X  Control X

Copy  Command C  Control C

Paste  Command V  Control V

Save Preset  Command Shift S  Control Shift S

Open Selected Category  Right Arrow  Right Arrow

Close Selected Category  Left Arrow  Left Arrow

Zoom In  Command +  Control +

Zoom Out  Command –  Control-

Fit to Screen  Command 0  Command 0

Actual Pixels  Command Option 0  Control Alt 0

Show Clipping  Option J  Alt J

Navigator/Loupe/Histogram (Levels)  Command 1  Control 1

Pixel Dimensions  Command 2  Control 2

Document Size  Command 3  Control 3

Settings  Command 4  Control 4

Sharpening  Command 5  Control 5

Film Grain  Command 6  Control 6

Tiling  Command 7  Control 7

Gallery Wrap  Command 8  Control 8

Show Browser Panel  Command Left Arrow  Control Left Arrow

Show Control Panel  Command Right Arrow  Control Right Arrow

Full Screen Mode  Command Control F  F11

Hand Tool  H  H

Zoom Tool  Z  Z

Crop Tool  C  C

Resize Keyboard Shortcuts
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Temporarily Select Hand tool  Hold Spacebar  Hold Spacebar

Rotate Crop Clockwise  Option Right Arrow  Alt Right Arrow

Rotate Crop Counter Clockwise  Option Left Arrow  Alt Left Arrow

Slow Nudge (selection)  Arrow keys  Arrow keys

Fast Nudge (selection)  Shift Arrow keys  Shift Arrow keys
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PART 4: ON1 EXPORT
Export is a special panel that is available in both the Browse and Resize  
modules. It the engine for the export process, whether you’re exporting 
final files from within Browse or from within Resize. The Export pane 
gives you much of the power of Resize in a quick and easy to use panel, 
letting you export your photos with incredible flexibility, ease and 
control.

The Export pane is always available, from any module, as long as you 
have a photo selected (you can also batch export files selected as a 
group in Browse).

To open the panel, click on the Export icon in the lower right 
corner of the main Resize window, or can choose Export 
from the File menu. Once selected, the Export panel opens 

on the right side of the Resize window, letting you select a group of 
options as you prepare to export a photo. By default, the panel includes 
three panes, which are fairly straightforward in their operation: File 
Type, Location, and File Names. These are the minimum options needed 
to export a file, but you can also add the following panes to the panel, 
expanding your export controls: Photo Size, Watermark, Sharpening, 
Tiling and Gallery Wrap.

FILE TYPE

The File Type lets you choose what format you want your photo to 
be exported as, along with a color profile that you wish to assign to 
the exported file. The type options are Photoshop, Photoshop Large 
Document, JPEG, TIFF, and PNG.

Saving as JPEG lets you choose a Quality setting, with 100 being the 
highest.

LOCATION

Click the Choose button to select a location, or click on the Save To pop-
up for more options, including:

• Current Folder will write the file to the same location as the 
original file.

• Folder lets you choose a location by pressing the Choose 
button

• Round Trip (this option is only available exporting through 
Adobe Lightroom) saves the file over the original and uses the 
same format, bit-depth, color space and name.

The Export panel lets you make simple 
exports, just by choosing an export file 
type, a location and a name, but you can 
also perform enlargements (using Resize’s 
Genuine Fractals engine), add gallery 
wraps and watermarks, tiling and more.



ON1 Resize 2018 User Guide	 Part 4: Export	 61

With regard to the other options in this pane, If Prevent Overwrite is selected the word ‘copy’ will be added 
to the file(s); otherwise it will overwrite your original image if the destination is set to Current Location. You 
can also have Resize open the folder you exported your image to by choosing the Show in Finder (Mac OS) 
or Show in Explorer (Windows) option from the After Export menu.

FILE NAMES

This option may be used to rename the file name. The options include: Current Name, Text and Number. 
The field to the right allows you to enter a custom name. The plus and minus icons will allow you to add or 
remove naming elements. Current Name will use the source name without the file extension. Text is used 
for assigning a custom text string. Number creates an automatically incremented number, starting with the 
number input in the field. Reset will clear all current settings.

PHOTO SIZE

The Photo Size pane displays the original image size when you first 
open it. You can simply type into the Width or Height fields to change 
the document size, or you can choose from a variety of preset sizes—
including standard photo paper sizes—by clicking on the pop-up menu 
underneath the Resize To pop-up.

NOTE: Export does not offer any options for cropping, and if you choose an 
aspect ratio that is different from that of your photo, on export, your photo will 
be cropped from the center point out to meet the new ratio. If you wish to crop 
to a different ratio, it is better to use Resize.

Keep in mind that the Width and Height fields are locked together to maintain the photos proportions. 
Changing the width will change the height proportionally. Export does not support non-proportional 
scaling. If you would like to change the proportions of the image it requires cropping.

The Long Edge and Short Edge options in the Photo Size pane are useful when you want to lock one edge 
to a specific length or width and don’t care about the sizing of the other edge. Simply choose which option 
is the important one for your photo, enter the dimensions, and Export will resize your photo accordingly.

The units of measurement can be switched by clicking the down arrow. You also control your resolution in 
pixels per inch. Use this setting to optimize for your output device.

The Photo Size Presets make it easy to set the width/height of your image in a preset size. Use the drop 
down menu to select a preset size or choose custom to create your own.

The Image Type drop down provides a few options for resizing:

• General (ON1 Resize) uses the ON1 Resize algorithm also known as Genuine Fractals: This is 
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the classic, patented, fractal-based algorithm that has made Perfect Resize the standard for 
over a decade.

• Low-Res JPG is best for enlarging low resolution JPGs (this setting use the bicubic algorithm 
method).

• Portrait works well for resizing portraits protects skin tones from artifacts (uses bicubic 
algorithm method).

• Landscape is great for Landscape photos (uses ON1 Resize algorithm).

• High Detail is great for images with many small items (uses ON1 
Resize algorithm).

WATERMARK

The Watermark module allows you to add an overlay to the image, most 
often used for your logo, signature or copyright. Watermarks generally 
need a transparent background, so make sure your watermark file is a 
PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you wish to 
use as your watermark.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the file is inset from the edge.

• Opacity: This sets the opacity of the watermark.

• Location: This grid sets the location of the watermark. Click on the square of the location you 
desire.

TIP: When working with watermarks, make sure your watermark file is 
sufficiently large for your usage. For example, if you want it to appear 2 inches 
wide on a 300-ppi image, your watermark needs to be at least 600 pixels wide. 
Or if you want it to appear across an entire photo—such as when posting to 
social media—it needs to be the same size as what you are exporting for the 
web, typically over 1000 pixels. Using a watermark file that is too small will 
create a pixelated watermark appearance.

SHARPENING

The Sharpening pane adds additional sharpness to your image, and are designed to be general options 
for either screen or print work. Using the Sharpening controls can save you the workflow step of adding 
additional sharpening before printing and can help compensate for loss of sharpness due to dot gain from 
your printer. Sharpening should only be applied at the end of your workflow just before printing. If you 
plan to do additional retouching or compositing work after resizing your image, you should disable the 
sharpening controls.
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TILING

The tiling feature in Export divides an enlargement into smaller pieces 
so that the image can be printed on a smaller printer.

For example, you might want to create a mural that is 8 feet tall by 12 
feet wide, but your printer can only print 24-inch wide strips. With the 
tiling feature you could automatically create four separate files that are 
24 inches wide and 8 feet tall, to create your mural in sections.

With the tiling feature all you do is specify the size of paper you have 
to print on and if you would like the pages to overlap. Then Export will 
resize your image and section it down into the individual tiles.

To use the Tiling pane, follow these instructions:

1.	 Set the Width/Height fields to the size and orientation of 
paper you wish to print on, or select the number of rows and 
columns instead.

2.	 Set the Overlap size. The overlap makes each tile overlap so you can tape multiple panels 
together and corrects for printer margins if you are not printing borderless.

The preview will show cyan guide lines for each tile that will be created.

GALLERY WRAP

The Gallery Wrap feature is designed to help you print on canvas. When 
making enlargements for canvas it is common to wrap a portion of the 
image around wooden stretcher bars. These are used for mounting 
the canvas. These are commonly called gallery wraps. However, if the 
photo has important detail near the edges of the image they may be 
lost in the wrapping process. The Gallery Wrap feature in ON1 Resize 
automatically creates extended margins by reflecting or stretching the 
areas near the edge of the image allowing the photographer to create a 
gallery wrap without having to sacrifice any of the original image. The 
Gallery Wrap feature allows you to select the thickness of the canvas 
mounting bars and offers a variety of techniques for creating additional 
margins.

To use the Gallery Wrap feature follow these instructions:

1.	 Set the Thickness control to the amount of margins you would like to add. A good rule of 
thumb is the thickness of the stretcher bars, plus half an inch.

2.	 Select the Type you would like to use.

3.	 If you wish to add an overlay to the wrap wings, set the color and opacity.
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The Gallery Wrap feature has several settings for adding margins and adjusting the look of the wrap. The 
Type pop-up has four options:

• Reflect: Copies an area equal to the thickness setting around your image, then flips each side 
and adds it as the margins. This is a good general purpose technique.

• Reflect Soft: Does the same as the Reflect method but softens the added margins.

• Stretch: The Stretch method takes a small area around the edge of the image and stretches it 
to add the margins.

• Stretch Soft: Does the same as stretch, but softens the added margins.

The Thickness slider controls how thick your canvas stretcher bars are. Two inches generally works well for 
most gallery wraps.

You can also darken the wrap or add a solid color to the wrap area with the Overlay Color add Opacity 
sliders.

EXPORT PRESETS

Presets remember all of the settings and details selected in the Export window pane. To save a group of 
settings as a preset, click the Save Preset button at the bottom of the panel. Give the preset a name, and it 
will appear in the Presets pop-up at the top of the Export panel.

NOTE: Unlike presets in other parts of ON1 Resize 2018, you can’t export or 
import presets from the Export panel.
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